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1.0a  What’s New in 3D-Coat 3.7?

Applink Connection Plug-Ins!

Totally Revamped Brush Engine!

New Voxel and Surface Mode Brushes.

Crisp Edges in Voxel Room with Boolean Cut off.

Instancing in Voxel Room

Precise Synchronization of Blending Modes with
Photoshop

Faster & Improved Paint Room Modes.

New Retopo Room Tools.

More Accurate and Intuitive Automatic Topology.

Totally Customizable Interface (hide or show any
button or menu item).

New, User-Friendly Ways to Share 3D-Coat Resources.

See page 71 for a full list of changes.
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1.0b  What’s New in 3D-Coat 3.5?

Completely re-engineered brush engine for super
smooth and fast sculpting and painting.

Create topology automatically with AUTOPO.

Create and edit multiple UV sets.

Save individual voxel layers as separate .3b files.

Multi-resolution and & caching voxel tools!
Sculpt and make changes on your low resolution
sculpture and the changes are automatically
transferred to the high resolution version.

Multi-threaded
merging!  Any
merging operation,
(moving voxel objects
between surface
mode and voxel
mode, move/pose
tools), is now multi-
threaded, speeding up sculpting operations and
workflow.

Color sampling via the clipboard allows the
selection of colors from Photoshop or user
defined reference images.

GTX 400 series video card support.

Improved support of Ptex to Renderman.

Custom resolution via Ptex.

Improved visual spline preset viewer.

Create and upload turntables automatically.

Paint over disconnected objects.

Many bug fixes and work flow improvements!
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Getting Started

2.1 Importing Meshes

With the middle column
selected, pick one of these

.obj files that you can see in
the menu from the opening
wizard. Or, select the File
menu and click on
File/Import/Model for per
pixel painting.  Then, choose
the “sample.obj” file, (it’s in
the Samples folder).

Upon importing an object you
will be prompted with the dialog
(left):

Initial subdivision:  This
number implies several
automatic mesh assignments for
painting with added
smoothness. A high poly mesh

and a mid-poly mesh are automatically created, with the mid-poly mesh
displayed in the viewport. Increase this number for added smoothness.

UV mapping type:  By default, the UV-mapping type is Keep UV. Checking
this option implies that you have a pre-existing UV mapped mesh, and, upon
import, it will remain the same. But, you can change it if desired. For this
example we’ll leave it as it is.

Uv set smoothing:  This option works only if you have chosen to subdivide
the model during import.

Auto smoothing groups:  This option creates smoothing groups
automatically. By specifying a value in the Maximum angle field, it becomes
necessary to check this option.

UV-set name: Enter the desired name for the UV-set.

Texture width:  Set the width of the texture.

Texture height:  Set the height of the texture.

NOTE:  If your video card has less than 256 mb of RAM, you should avoid
textures larger than 2000 x 2000 pixels.

Micro-vertex Painting

If you choose File/Import/Model for micro-
vertex painting, and you have selected a file -
(we recommend to start with “sample.obj” in
the Samples folder). As with the previous
method, you will see a number of options
which you can specify upon importing your
object.

Millions of polygons:  This number
represents the number of polygons that 3D-
Coat creates automatically, and which it uses
internally to provide smoothing and normal
map resolution and production. This number
should always be larger than the number of pixels in your texture map.

Carcass resolution (polygons):  3D-Coat’s internal mesh conversion is
comprised of 2 levels of detail for 2 different purposes: the carcass mesh has
a mid level of detail, (which is for viewport display), and a high poly mesh,
which is used to produce a normal map, on the fly. Adjust this number to
allow for the detail you anticipate you will apply to your model.

Smooth object:  Check this box to add additional smoothing upon
importing your model.  For this example, let’s check this box.

UV mapping type:  By default, the UV-mapping type is Keep UV. Checking
this option implies that you have a pre-existing UV mapped mesh, and, upon
import, it will remain the same. But, you can change it if desired. For this
example we’ll leave it as it is.

UV sub-patch smoothing:  This option allows you to smooth the sub-
patches of your UV map, if you have any.
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Pressure positions:  This option specifies that the initial vertex positions
be saved, thus compensating for a shift which occurs when smoothing with
extra stylus pressure.

Ignore smoothing groups:  This option imports a model without its
associated normal map. The model will be smoothed automatically.

Invert normals:  Inverts the normals of your imported model.

Auto smoothing groups:  This option creates smoothing groups
automatically. By specifying a value in the Maximum angle field, it becomes
necessary to check this option.

UV set name, Width and Height function the same as described above.

2.2 Customizable Interface

Like many other applications, 3D-Coat lets you customize
your workspace to suit your needs. You can hide or show
windows, move tabbed popup windows around and even
dock/undock them, or turn them into floating windows.

If you don’t need or want to see a
particular window, simply close it. You
can always restore it to the interface
through the Windows menu , at any time.
Customizing your workspace makes 3D-
Coat work for you in the way which best
suits your needs and workflow. Using the

“Customize UI” option from the “Edit” menu allows you to
hide or show any menu or interface item.

2.3 Tabbed Popup Panels

The video below starts by moving tabbed
popup windows around. We will discuss

how to undock and dock tabbed windows and how to create floating
windows. Tabbed windows are flexible in that you can change their width
and length and also their location. This can be helpful if you’re using 3D-Coat
on a notebook computer with limited screen space available. WATCH VIDEO

2.4 Pop-Up Panel Menus

Many Panels in 3D-Coat have a small
down-arrow icon in their upper right
hand corner. Clicking and holding on this
icon reveals the Tab-specific options
available.

For example:  suppose that you would
rather view your brush alpha icons at a
smaller size - simply click on the down-
arrow icon and select the Tiny option.

2.5 Navigation Panel

The Navigation panel is located on the top right corner of the viewport. This
panel gives you access to the viewport navigation functions, all of the
Camera settings and focus functions and viewport light positioning and
intensity settings. From left to right, these are the functions of each icon:

Ambient light intensity:  Dragging with the left mouse button, right
or left increases or decreases the scene’s ambient light property.

Primary light intensity:  Dragging with the left mouse button, right
or left increases or decreases the intensity of the primary scene light.

Primary light direction:  Dragging with the left mouse button adjusts
the position of the primary light in 3D space.

Rotate the view:  Dragging with the left mouse button adjusts the
user view by rotating the main camera around object in focus.

Pan the view:  Dragging with the left mouse button adjusts the user
view by moving the main camera right, left, up and down.

Zoom the view:  Dragging with the left mouse button right or left
moves the main camera closer or farther away from the object in focus

Vary the field of view:  RMB to reset it to default.
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Frame object:  Fills the view using the object’s bounding box.

Focus on brush:  Zooms the view to the area the brush is hovering
over.

Set camera to default position.

Toggle perspective/orthographic projection.

2.6 Camera Options

Custom navigation:  Choose between 3 styles of
navigation - 3D-Coat, Maya or Zbrush
style.  Using the default, 3D-Coat style,
view rotation is controlled with LMB-
drag, view panning with MMB-drag and
view zooming with RMB-drag. When
using certain tools and when wanting to
retain the current mouse position, simply
hold down the Alt key and use the same
mouse buttons as defined above.  Hold
down “Shift” to snap to a regular axis.

Customize navigation:  Opens a panel
that allows total customization of all
navigation commands.

Background:  A set of options that lets
you set a variety of view backgrounds as
visual references.

Add camera shortcut:  Stores camera positions and current material
settings for rendering fly-throughs and sequences. The other choices let
you delete and switch these stored camera positions.

Rotate . . .  These commands set the pivot point for the view camera.

2.7 Setting Up Backgrounds and Reference Images

There are 2 different kinds of Backgrounds:  those which simply fill the
background of the 3D viewport, (and stretch to fill, if needed) - and those
that are set up manually for use as sculpting or painting reference images.

Viewport Background:  Select Use background image and choose your
image from the opening dialog. The default image is a starfield.

Reference Images:  The 3 bottom choices
allow you to pick 3 separate images - 1 for
each view axis, X,Y and Z.

Edit image placement:  When selected,
this option provides each image plane on
each axis with a Transform widget and
accompanying dialog settings for
adjusting its position, scaling, rotation and
view opacity.
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3.0  Right Side Panels

3.1 Brushes Panel

These images represent what other programs call
“Alphas”.  They can be made as free-form grayscale

images, using a paint program, or as an actual 3D
object that has been converted to a grayscale image,
internally, in 3D-Coat.

Adding Brushes:  You can add your own brush alphas
in the following formats: .tga, .psd, .png, .jpg, .tif,

.bmp, .abr, .mclp, as well as the 3D formats .obj and .lwo. Choosing to load
brushes in the two 3D formats opens a dialog that lets you rotate, scale and
set the resolution for translation into the Brush format. To add a new brush
alpha, simply press the + icon and choose the file you want to add.

Painting & Sculpting with Brushes:   You can begin painting or sculpting
by selecting one or many brushes from the Brush panel.  More than one
alpha shape can be selected by holding down Ctrl or Shift and making
multiple selections from the panel.  Selecting multiple brush alphas enables
the program to use them randomly as you paint or sculpt.

Resizing and setting Brush depth:  Brush size can be altered by holding
down the RMB and dragging left or right ion the working object.  The
keyboard can also be used to set the brush size - just use either the “[“ or
the “]” keys.

Painting or sculpting with depth can be adjusted by dragging up or down
with the RMB depressed.  Alternately pressing the “+” or the “-” key on the
keyboard achieves the same thing.

3.2 Brush Options & Settings

Brush Toolbar Settings: Just above the viewport you can find the Brush
toolbar which provides settings for the most commonly used brush
settings. Both radius and depth of the brush can be set here, as well as
whether these settings are affected by tablet stylus pressure.

Brush Options Panel:  At the top of
the panel is a preview of the Brush
alpha shape followed by a series of
behavior controls.

Brush rotation:  This sets the initial
orientation of the alpha at the
beginning of the stroke.

Zero pressure radius:  When using a
tablet stylus, this number indicates the
default radius at the beginning of the
brush stroke.

Depth modulator:  The default depth
for each brush being used.

Rotation amplitude:  Sets the
amplitude for additional brush rotation.

Radius variation:  Sets the percentage
of random brush radius variation.

Depth variation:  Sets the percentage
of random brush depth.

Opacity jitter:  Defines the randomness of the brush opacity setting.

Jitter:  The overall randomness of brush behavior.

Hue jitter:  Defines the randomness of the brush hue when used for painting
color.

Brightness jitter:  Varies the brightness, randomly, over the course of a
stroke.

Saturation jitter:  Varies the saturation of the primary color, randomly, over
the course of the stroke.
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Vary color each stroke:  Use
this option  to produce painting
effects, like fur or hair, when you
need to either vary the
Hue/Saturation/Brightness as
you paint a single stroke,
(variegated strand color), or
when you want each stroke
made to have a slightly different
Hue/Saturation/Brightness - as
determined by the

corresponding “Jitter” setting.

Random flip (x, y):  This randomly flips the selected brush either across
its x or y axis while painting.

Paint with dabs:  Creates paint or sculpting “dabs”
which occur at some set spacing - as determined

by the “Spacing” control.

Rotate along stroke:
When using brush alpha
shapes that you want
to align like the bristles
of a brush - so that they
change direction as the
brush changes direction, all along the stroke -
use this option.

Skip eraser:  Disables the “eraser layer” of the brush.

Strict alpha:  Use this setting to cause both sculpting and painting
brushes to strictly adhere to the shape defined by the brush alpha.

Flattened stroke:  Use this brush setting to mimic Photoshop brushes for
improved stroke overlapping with a truncated alpha shape.

Fade on edge:  All strokes painted with this option checked will have a
smoother edge transition.

Use spacing:  When used with the “Paint with dabs”
option, adjusting the “Spacing” percentage slider
determines how close or far apart the paint dabs are
applied.

Advanced Brush Settings Panel

Refresh brush preview: Refreshes the Brush alpha
icon.

Brush Settings:  Opens the “Brush Options” panel.

Add new folder:  Allows you to choose a pre-defined folder of Brush alpha
shapes to be added to the “Folder” list.

Add existing folder:  Allows you to choose a single Brush alpha from a folder,
thus adding all the alphas in the folder to be included in the folder, now
with the name of the chosen file,  which is then listed in the “Folder”
selection list.

Add Brushes from package:  Adds Brush alphas that have been packaged
into a “penpack” file format.

Folder:  A selection list of all folders you have enabled 3D-Coat to access.
The icons from this chosen folder will then be visible in the “Brushes” panel.

Tiny:  Sets the Brush alpha icon set to a very small size.

Normal:  Sets the Brush alpha icon set to the default size as seen when the
program opens for the first time.

Large:  Sets the Brush alpha icon set to a size larger than the default size.

Huge:  Well, you can guess the size of these - (better try it out and see).
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3.3 Brush Alpha Edit Menu (Right-Click)

Right clicking on any unselected Brush
alpha invokes a comprehensive list of
alpha editing functions.

Brush Settings:  Opens the “Brush
Options” panel.

Delete brush:  Deletes the selected
Brush alpha.

Save to PSD/TIF:  Saves the selected
Brush alpha to either file format.

.PSD is more intuitive, while .TIF is more precise, giving you more channels
to save and manupulate elsewhere. .TIF can contain 7 channels - RGB, al-
pha, height, specular and the “Erase mask”.

Load from PSD/TIF:  This replaces the alpha that has been right-
clicked on with an of your choice, save in either the .psd or .tif for-
mats.  To create a brush in a 2D painting
application, you must have 4 layers each
corresponding with the 4 main channels
of a brush in 3DC, they are: Color, Height
Map, Specular and Erase Mask.

If all the .tif channels are used, they will
all be imported and used according to
the table below.  If you only use some of
the available channels, those you do im-
port will also be used according to the
table below.

1 CH: A&H
2 CH: 1 – A 2 –H
3 CH: 1, 2, 3 – RGB, 2 – A, H
4 CH: 1, 2, 3 – RGB, 4 – A, H
5 CH: 1, 2, 3 – RGB, 4 – A, 5 – H
6 CH: 1, 2, 3 – RGB, 4 – A, 5 – H, 6 – Spec
7 CH: 1, 2, 3 – RGB, 4 – A, 5 – H, 6 – Spec, 7 – Erase mask

Edit in external editor:  Creates a “live”
connection between 3D-Coat and the ex-
ternal editor you have specified in the

“Preferences” section.  The default editor is
Photoshop.  Selecting this option opens
the specified editor and any changes that
you make and save from the editor are au-
tomatically loaded back into 3D-Coat.

Each brush includes 4 Layers:  In 3D-
Coat, the Layers that are imported and
used arrange themselves into Color, HeightMap, Specular and
EraseMask.  The order of these Layers, in the external editor, are im-
portant.  Looking at each of these individually:

Color:  This contains the Brush color as well as its corresponding
Transparency mask.  This mask affects the Specular Layer, as well.

HeightMap: Depth is synonymous with this definition.  The “zero”
height of this Layer corresponds to “middle gray” or (127, 127,
127). Darker values correspond to concave area and lighter values
correspond to convex areas.

Specular:  White represents maximum specularity.  Black repre-
sents absolutely no specularity, with shades of gray representing
intermediate values.  The Color Layer mask also interacts with this
Layer.

EraseMask:  This Layer is used to create Brush alphas that ignore
certain values, in other layers, while painting.  Remember that this
mask affects the lowest Layer in the list.

Edit as 16 bit .TIF:  This allows you to save in 16 bit format, rather
than 8 bit.  Using this option causes the Brush alpha to be saved as
a .psd file, allowing it to be reloaded automatically, each time it is
edited and saved in the external editor.
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NewFolder, (etc.):  This option will allow
you to copy the Brush alpha, (that you
right-click on), to a folder named in the

“Folder List” that you have previously
defined.  All the “New folder” names you
have defined will appear here.

3.5 Brush Options Tool Bar

The most commonly used Brush settings appear in this tool bar.  Different
Brush types require different options, so these fields and sliders change,
depending on which Brushes you are currently using.  Also, these fields and
sliders change, depending on which Room you are currently working in.

Paint Room

Interpolate:  Sets the intensity of Brush stroke smoothness - simulating a
smoothed spline based stroke.  Uncheck this if you want no additional
stroke smoothing.

Radius:  Sets the diameter of the Brush “tip”.  You may toggle between
using Stylus pressure to influence this setting or not, by clicking the
Brush/Mouse toggle.  Press the “Lock” icon to set the diameter to a
constant value, preventing further adjustment.

Falloff:  Controls the softness of the Brush stroke “edge” , by adjusting it
with a “falloff curve”.

Depth, Color, Specularity Buttons:
When no “X” covers each of these icons,
you have enabled painting with some
or all of these channels.  The “X”
disables some or all of these same
channels. Hovering the cursor over
each of these causes a menu to appear
that contains brush stroke options. The

shortcuts for obtaining these menus are, “D”, “C” and “S”.

Mouse, Pen and Lock Icons:  These two icons indi-
cate what mode you are painting in. You can toggle
from one to the other simply by LMB clicking on the icon. The Mouse icon
locks pen pressure to whatever value you have in the respective setting
the icon is next to. The Pen icon allows for pen pressure directly from your
stylus. The Lock icon will lock the “on screen” size of the Brush. It is conve-
nient when you want to change radius of the pen by simply moving the
model backward and forward in space. The Lock icon near depth slider
lets you vary the pen radius without variation of absolute pen depth. In
standard mode, radius and depth are proportional.

Minimizing on the Tool Bar:   You can also change settings on the tool
bar, such as falloff, specularity,
etc. This can be done by clicking
in the immediate area around the
setting you wish to minimize. The
image here shows the area to
click to achieve this.

Depth:  Manually adjusts the alpha depth of the current Brush.  Use the
Brush/Mouse toggle to enable or disable stylus  pressure influence.  The

“Lock” icon keeps depth constant and prevents changes.

Smoothing:  Adjusts the  Brush alpha smoothing.  Use the slider or enter
values in the corresponding field.

Transparency:  Adjusts the Brush alpha transparency.

Specularity:  Adjusts the Brush alpha specular value.

Mouse & Stylus Shortcuts

Brush Radius and Depth can be adjusted, on the fly, by
holding down the RMB and dragging left or right, (for
Radius) - and dragging up or down, ( for Depth) of stroke, in
the viewport.  The brush cursor will automatically reflect
these changes.
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3.6 The Strips Panel

The Strips panel offers an alternate selection of
Brush tips, which repeat over the length of a
stroke.  Choosing a Strip shape overrides the
alpha shapes in the Brushes panel.  Strips work
best in the Paint Room for creating detail with

normal map depth, in concert with per-pixel painting modes, or, for actual
displacement painting while using the micro-vertex method.

In this illustration, the bandolier was created with a
standard Strip shape, totally within the Paint Room -
using the micro-vertex method of painting.

For similar functionality in the Voxel Room, use the
“Curves” tool with a repeating Spline shape selected
from the “Splines” panel.  The Strips panel uses the
same methods of adding folders and individual strips
as the Brushes panel.

3.7 The Masks Panel

Masks are used as a way to specify an area for
sculpting or texture painting with Brush depth and
transparency.  Masks are essentially stencils.

The mask, in conjunction with  materials can be moved and rotated
independently using the new navigation controls.  Masks and materials,
both, can also be rotated precisely 45 degrees by using SHIFT key.

If you choose to display mask/ material in at least one of the channels
(Depth and/or, Color and/or Specular), a new panel shows up on top.

Mask/Material Preview Panel:  With the Preview Options panel you can
adjust the Masks & Material
preview parameters as follows:

Hide/Show/Auto:
Hide/show/auto-hide full-

screen view of texture. You can switch mode with the hot key “H”.

Unlock/Lock:  Lets you scale and texture automatically while scaling and
moving the model.

Flip X:  Reflect mask image, mirror-like, across the horizontal axis.

Flip Y:   Reflect mask image, mirror-like, across the vertical axis.

Paint:  This mode lets you paint, using your mask or material.

Distort Image:  In this mode you
can distort your mask or material
directly with your brush. You can do
some very unique texture work
with this feature. It is great when
you have an image that doesn’t
match the mesh exactly. You can
then use this tool to shape the
image to match the mesh more
precisely – so that you can then
paint with a material or mask. As
you can see in the image, the jaw
line, nose and silhouette of the
head have been shaped with the
distort image feature.

Reset:  Places the texture in its initial position.

Clear/Save/Load Distortion:  With these options you can clear, save and
load your distortions.

Mapping Method:  There are two methods you can use here. From Camera
and Cube Mapping. From Camera lets you project the method through the
viewport. If the Cube Mapping application type is selected, the material
preview will be displayed on the pen only, as opposed to full screen (when
From camera is selected). On the right there is a slider responsible for
transparency when viewing the Masks/material.

Opacity of preview:  Percentile based opacity controls.
Adding a new mask or material is done exactly as you do with Brushes and
Strips.
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3.8 The Materials Panel

The Materials Panel contains thumbnails of each
of your chosen Materials, as separated and
defined in your various Material folders.
Individual Materials can be added to the open
folder display with the “+” icon.

Right-clicking on a Material opens a dialog that
lets you assign a separate texture image to each
of 3 channels: Depth, Color, (or Diffuse) and

Specular.  You can choose to use all or
some of these channels to define each
Material.

Left-clicking on a Material thumbnail
will tile the Material image across the
whole screen.  Left-clicking the grey “X” disables the use of all materials
and removes the material preview from the Viewport.  Pressing “M” on your
keyboard opens a new Materials panel.

In the example on the left, we only want to
paint with a Color texture on the model, so
Depth and Specular channels are disabled. You
can enable or disable any or all channels, as
needed.

All of the controls for masks, as detailed in that section, are exactly the same
as for Materials.  You can see the power of using Materials in the picture
below.

3.9 The Layers Panel

The Layers Panel changes depending on which
Room you are working in. In the Paint Room,
Layers are used much like you would in
Photoshop or other painting applications, where
aspects of each Layer can be controlled
independently, such as blending modes and
opacity - but with additional control over how
Depth painting affects the Layer in question.

Right-clicking on a Layer name
opens a menu of addition commands.  Icons at the bottom
of the panel are, in order, for the following functions: New
Layer, Delete Layer, Merge Layer downward, Move Layer
up, Move Layer down, (in the list).

Layer visibility:  Simply toggle the “Eye” icon to hide or
show the Layer in question.
Hold down the “Alt” key to hide  every layer except the layer
clicked on.

Layer Blending:  Go to the Blending tab.

Duplicate:  Duplicate the selected Layer.

Flip Layer and Duplicate and flip:  Duplicate the Layer
and flip it, using topological symmetry.

Flip Layer:  Flip the Layer using topological symmetry.

Copy Blue to Re:  Copy the blue part of a mesh to the
red part. You can define blue and red parts in the
topological symmetry tool.

Copy Red to Blue:  Copy the
red part of a mesh to the
blue one. You can define the
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blue and red parts in the topological symmetry tool.

Copy Channels:

Merge Visible:  Merges all visible Layers. “Undo” is
unavailable.
Merge Up. Merge this Layer and the upper Layer.

“Undo” is not available.

Freeze painted pixels:  The freeze value will be set
equal to the Layer’s transparency.

Freeze Transparent Pixels:   Freeze the transparent
part of the Layer. It is important if you want use the
transparency mask of the current Layer on another
Layer. Use CTRL+LMB on the Layer to perform the
same action.

Apply Layer Mask:  Apply a Layer mask to Layer. The Layer mask is a
reference to another Layer that masks this Layer.

Apply Blending:

Color to Specular:  Transforms color brightness to the specular channel.

Invert Color:  Inverts the color of this Layer.

Invert Specularity:  Inverts the specularity of this Layer:

Fill Unfrozen:  Fills the unfrozen parts of the Layer with the current color
and specularity.

Fill by Mask:  Fills the Layer with the current color and specular using its
current transparency mask.

Clamp depth of the layer:

Set Height to Zero:  Sets the height to Zero on all the Layers.

Make Transparent:  The Layer will become fully
transparent.

Remove Specularity:  The specular channel will
be set to Zero.

4.0 The Blending Panel

This panel contains a more advanced set of param-
eters.  Let’s take a look:

Lock transparency:   This lets you draw on a Layer
without changing its transparency. Essentially, it
lets you edit the current colors on a Layer without adding more.

Depth modulator:

Color opacity:

Emboss power:

Contrast:

Brightness:

Specular contrast:

Specular brightness:

Linked Layer:  This drop-down list enables you to mask the current Layer
with another Layer. The transparency and depth of the current Layer will
be modulated by the selected Layer transparency.
Inverse linkage. An inverse Layer opacity will be used as a mask.

4.1 The Sub-objects/Materials Panel

This tab displays all imported meshes into a
Layer system.  Essentially, each Layer is an
object, and can be toggled on/off for a number
of things, like its visibility or locked/unlocked
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5.0 The Painting Modes

Throughout the
development of 3D-Coat,
new painting methods and
modes have been
developed that have been
designed to meet different
texture import and export
needs.

As of version 3.5, three
modes are supported:
Micro-Vertex, Per-Pixel and
Ptex.  It can be confusing
which one to use and for what it is best suited. A general overview of the 3
modes can help in this decision:

Use Per-Pixel mode for both high resolution models and low
resolution models, where you need maximum compatibility with other
environments and where extreme clarity of texture is required.  Note that
Depth painting within this mode only supports the real time generation
of a normal map, rather than actual painted displacement - but, based on
this information, a displacement map can be exported as well as a normal
map.

Use Micro-Vertex mode when you desire to add high frequency,
actual displacement while painting in the Paint Room.  The exported
textures, however, will not be as clear as those exported from Per-Pixel
mode.  This mode is less responsive, in real time, than Per-Pixel mode.

Use Ptex mode when you intend to create super high resolution
texture maps that can be used with applications that read Ptex format, or
which have been tested to work well with 3D-Coat converted Ptex UV
maps.  Also, texturing using Ptex is an ideal way to get the highest texture
detail for use in baking to an object with a similar or same shape, but
having an entirely different UV map or level of subdivision. See the
Texture Baking Panel.

With the microvertex approach every face, (quad only allowed), was
represented as a patch N×M vertices (N and M could be different for every

face). Every vertex had color and coordinates in space, so every kind of
displacement was allowed. However this approach was limited because it
was very difficult to edit meshes with non-quad faces, and projecting a
patch to texture resulted in a loss of quality, so it was difficult to import a
texture, edit it and then export because the after-export texture appeared
to be slightly blurred. So we decided to implement Per-Pixel Painting.
Here are the basic points of this technology:

� Painting is performed not over vertices but over pixels on the tex-

ture directly. It looks like every pixel on the texture is represented

as a point in space.

� Every pixel contains any number of Layers of color, opacity, nor-

mal displacement and specularity.

� Every Layer can be blended with the previous one using

well-known blending operations for color and displacement.

� Every texture point in space has its neighbors in a per-pixel repre-

sentation. It is important because it lets you not only paint over

the model but also to perform non-local operations – like blurring

and sharpening with brush.

� Some operations are performed in space, like painting, filling, ap-

plying curves, some in projection, like smudge. All this is transpar-

ent to the user.

� Most operations can be performed (optionally) not only on the vis-

ible side of an object but on the invisible too, like applying curves,

filling, painting rings, rectangles and polygons over the surface.

� Exchange with other applications becomes really fast and has no

quality loss, so you can use 3D-Coat in any stage of the pipeline

for a final touch or to perform full texturing.

� You can import a normal map and use it as a reference for texture

painting. Normal maps can be changed too, you can apply some

smoothing (not over seams) or fade some areas.

� It creates seamless painting and smoothing over textures.
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Per-Pixel painting has only one
disadvantage when compared to
Micro-Vertex painting:  per-pixel
painting does not support vector
displacement, only normal
displacement. Sometimes this
functionality difference is important,
so we left both approaches as
options.

For example, using the Micro-Vertex
approach to paint on baked voxel
sculptures gives you better results.
Additional  advantages of per pixel
painting are as follows:

� The ability to affect pixels on the back of the model, (filling,
blurring and applying overall effects.)

� The painting quality does not depend on the distance from the
object to the camera.

� More precise painting: what you see is what you get.
� The key advantage over Micro-Vertex painting is the ability to blur

pixels underneath the brush. This is possible because every pixel
has a neighbor toward which it can be blurred.

5.1 Painting With Depth

Painting, in 3D-Coat, can take place in up to 3 “channels” at the same
time - Depth, Color and Specular.  Enable or disable whichever channels
you wish to use, simply by clicking on the corresponding icon in the top
tool bar.

Hovering the mouse pointer over
each of these icons brings up an
additional menu of options.
The Additive painting option is
best illustrated in the diagram to
the right.  When not enabled,
crossing brush strokes plateau at

the same level of depth - when enabled, the
same strokes will cause paint to “pile up”
wherever the strokes intersect.   Also, if the
option is disabled, the overlapping
behavior is applied only on strokes drawn in
the current Layer.

The depth of your painted stroke can be controlled, “on the fly”, simply by
holding the Right mouse button down and dragging up or down. The
depth intensity is visually indicated by the center colored and contoured
line within the painting cursor, (red by default).  The shape of this center
contour reflects the shape of the Alpha you have selected in the primary
Brush Panel.

Depth intensity can also be controlled with the keyboard by pressing
either the “+” or the “-” key, or by rolling the mouse scroll wheel forward
or backward. When using a stylus, use less pressure to avoid stroke

“overdrive”.

NOTE:  When painting in the Micro-Vertex mode, and your mesh is low
resolution, painting with high depth intensities may cause abrupt mesh
distortion.

Smoothing of your painted depth stroke can be adjusted by using the
“Smoothing” slider in the top Brush tool bar or by holding down the “Shift”
key and the Right mouse button and dragging up or down.  The
keyboard shortcut for this function is either “Shift +” or “Shift -”.  The
center brush profile line becomes green, by default, when you are in
Smoothing mode.

5.2 Painting with Color

When no material is selected, you can paint with
basic color or randomly with the 2 colors
chosen from  the main Color Swatches.  You can
also paint with a random Blend of colors,
chosen between those 2 swatches.  Invoke the
Color Pop-up with the “C” key, where all of
these modes are available.
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5.3 Painting With Specular
The degree of shininess that you wish to paint with, for
Alpha Controlled application, or for Specular mapping
contained in a Material, is adjusted with this Pop-up
panel.  Use these functions to turn off Specular painting,
to adjust the intensity of the effect, or to add a Blending
amount to your Specular map or “flat” Specular application, when no map
is found.  Press “R” on your keyboard to bring this panel to the front.

5.4 Painting With Materials

All 3 Paint Channels, when enabled, will
react with any Material that is currently
selected from the Materials Panel.  Every
Material can contain a separate texture for each of its channels - Color,
Depth and Specular.  If no Material is selected, (disable the use of
Materials by clicking the large “X” in the Materials Panel), then each Paint
Channel will respond based upon which Brush Alpha has been selected .

New Materials can be added to an existing Material
Folder simply by clicking on the large “+” icon in the
Material Panel.  The thumbnail image of each new
material is created based upon which texture image
you select for that Material’s “Color” channel.

New Material Folders can be
created or loaded by pressing the
small “Down Arrow” at the top

right of the Material Panel and selecting either the
“Add new folder” or “Add existing folder” options.

Painting Shortcuts
Some artists like to paint and texture with as much “blank” screen space
as they can get.  They dislike the clutter of many interface elements - and
3D-Coat allows you to work in just this way.  Just hide those elements of
the interface that you find distracting and use keyboard shortcuts that
give you access to the tools you need, only when you actually need them.

One of the most convenient “Pop-Up” tool panels is the “Tool/Color”
panel.  It contains all of the Painting Tools from the left tool panel, in
addition to a handy color wheel.

Paint and texture, freely, and press the “Spacebar” when you need to
change to a different Paint tool or color.

To access the Main Paint Functions panel, just
press “~” on your keyboard to bring it to the
front of your work space - right at your cursor
location.

5.5 The Color Picker
There are 5 flavors to choose
from, as shown at left.  These are
made available  by left clicking
on the color swatches in the top

left of the main Paint Tool Panel.  The pickers work just like
their equivalents in other mainstream painting applications.

Color Image Window:

The exception is the “Image Color Picker”, which
allows you to assign an image of your choice - from
which you can choose any hue present in the image
for painting.  This is also quite handy for keeping a
reference image open at all times during sculpting
or painting operations.  You can manipulate which
portion of this image is visible, and its position in
the window, with the 3 controls just underneath it
and to the left of the image window.   Select the

image of choice with the
“Select” button or “Paste”
the image from your
Clipboard.  Once used, an
image becomes available via the “drop down
arrow” to the right of the image name.
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5.6 Custom Color Palettes

Create your own custom color palettes via the
“Windows/Popups/Color Palette” menu.  (you
can assign a keyboard shortcut for this). Right
click on any color to Delete, Insert or Edit any
color using the Color Picker.

New Color Palettes can be created and
saved for later access - these are stored in
the main 3D-Coat folder, subfolder

“Palettes”.  Once stored, these palettes will
always be available in the list - accessible
through the “drop down arrow” menu.

NOTE:  To disable the use of Color, as
defined by the Color Swatches, Right
click on the Color Swatch - and an “X” will
appear over the Color Swatch, informing
you that you are no longer influencing
painting with these colors.

5.7 The “E” Panel

This Pop-Up panel contains some of
the most powerful tools and

functions within 3D-Coat.  Not only does it contain tools for many
different painting modes, for use with graphics tablets, but it also doubles
as an arsenal of selection tools and voxel extrusion/intrusion tools.

Some of the tools work in conjunction with Brush Alpha shapes, and some
have an adjustable set of parameters which determine things like edge
sharpness and shape.  Precise shape extrusions and intrusions can be
made because of the “spline-based” nature of these tools - as well as open
lines and curves with adjustable edge falloff.  “Load shape” lets you use
imported vectors and images for these functions.

Tablet-Based Tools/Functions

The first 5 tools in the “E” panel provide a broad range of effects for use
with your pressure sensitive drawing tablet.  There are good descriptions
for each one when “Hints” are enabled in 3D-Coat “Preferences”.

If you are using a mouse, the first tool is a very good choice that allows
good control of each stroke.

Dots, Lines, Curves and Stamps

These tools/functions are fairly self-explanatory and good descriptions are
available also via “Hints” when they are enabled in the “Preferences”
panel. Use the “Stamp” mode, (4th in this group), when you need to
precisely position Alpha-based details on the surface of your model.

The “Curve” mode is good at evenly extruding things like consistent and
smooth moldings and grooves.  “Dots” mode lets you paint with spaced,
Alpha-based Paint “dabs”

Closed Shape, Spline Tools

These tools are the most frequently
used Brush tool modes for several reasons:  the ability to make precise
selections, through cuts, extrusions and intrusions - as well as precise
shapes created in “open space”.

They are particularly well suited for the creation of “hard surfaced” detail
for voxel models.  One example would be the creation of precisely defined
metal plates of exact thickness, panels and windows which conform
exactly to the surface of any voxel shape.

As selection tools, these Closed Spline Tools work “all the way through” your
model - allowing for closely defined areas to be hidden, masked or “Frozen”

- and they make shorter work of defining
areas of density when using AUTOPO
functions.  Experimentation is a must for
learning how powerful these tools are.
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Some Closed Shape, spline tools -
when used with the voxel sculpting
tools - operate only on the visible
surfaces of your model.  When using the rectangle, ellipse or contour tools,
you can work on the back side or your model by un-checking “Ignore
backfaces”.
WATCH VIDEO

Draw with closed spline/B-spline: Add spline control points with the
LMB. Press ESC to finish. Near the control points you will see a small

spline menu button. Press it and you’ll be able to choose from various
options:

Apply:  Apply a spline action. You may use ENTER
instead. With “Ctrl” pressed it will produce an

“intrude” effect.

Clear:  Clear all control points.

Detach from surface:  This command detaches
any control point that has been  attached to a
surface - (a control point becomes attached if you
add it while the cursor is over the surface).

Add points:  Use this command if you pressed ESC
after adding control points and then you decided to continue. Press ESC
to finish.

Edit points: This is the default mode after you’ve finished adding control
points. Hover the cursor over a spline in the place where you want to add
another control point (when you see a red dot, press LMB to add it).
Drag any control point with LMB. Use RMB over any control point to toggle
vertex sharpness.

Transform all:  Transform the whole spline with the widget (rotate, move,
scale vertically, horizontally, proportionally).

B-Splines:  Use B-Splines by
default. In this mode the spline will

be smoother and will not go through the
control points. Use it with vertex
sharpness to get a variety of shapes.

Edit points table:  Set numerical values of
each control point. In this window you can

also set
the
type of each control point: Sharp
(makes sharp corner at this point), B-

spline (simple spline if unchecked).

Scale:  Set the scale factor and press the “OK” button or ENTER.
Rotate:  Set the angle of rotation and press the “OK” button or ENTER.
Flip horizontally:   Flip the whole spline horizontally.
Flip vertically:  Flip the whole spline vertically.
Save.:  Save the spline to a file.
Load:  Load a previously saved spline from a file.

Paint single polygons:  (Only for use
in the Paint Room). This mode lets
you paint single polygons with one
click - or paint up to the borders of
original, source polygons,
continuously.

Border width:  This slider is
responsible for the border width when
drawing with the rectangle, ellipse or
contour tools.

Ignore backfaces:  This is a switch which toggles between drawing on the
back side of surface polygons and not. This option is available only when
drawing with the rectangle, ellipse or
contour.

Depth limit:  Limits the tool’s depth of cut on underlying geometry.
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6.0 The Paint  Room

In the “Paint Room”  you have access to a comprehensive set of painting,
texturing, adjustment and texture transformation tools.  These tools are
located in the left side panel. You can also press the “Spacebar” for quick

access.

Paint and Material Brush:  This tool works in combination with the 3
Paint Channels, (Depth, Color, Specular), and its effect is influenced by
which Alpha shape is chosen from the Brush Alpha panel.  If no material is

selected, the basic color or colors that are applied are
indicated by the 2 color swatches at the top of this
tool bar.  If a Material is selected, a combination
of interactions occurs, based on the Brush Alpha

shape and those Material channels which have textures assigned -
as well as which basic Painting Channels you have “turned on”.  Tablet
response can also be set via the “E” panel - along with various curve and
closed spline methods of paint application.  (See “The “E” Panel)

Airbrush:  A softer brush which has an “accumulation” coefficient.
This brush produces the most profound “dabbed” painting effect when
used with the “Paint with dabs” Brush Option selected.

Clone Brush:  Like traditional painting applications, this brush “clones”
texture from one randomly selected area to another, (“Ctrl-LMB” to set

source.  See complete description on the next page.

Eraser:  Just like it sounds, but erases all information from whichever
basic Paint Channels are enabled, (checked).

Eyedropper:  More powerful than an ordinary eyedropper tool - this
one samples the information from all 3 “basic” Paint Channels, (Depth,
Color and Specular).

Fill Tool:  Fills contiguous areas of color with either a single
Paint value for all 3 basic Paint Channels, (Depth, Color, Specular),
or with a selected Material, (which uses up to 3 textures for each
of these same channels).

6.1 The Texture Adjustment Tools

Color Operations:  This tool has 10 different
color adjustment functions which are “Brushed on”,
reacting with Alpha and/or choice of “E” panel tool:

De-saturate:  (decrement the chromatic level) When you press “Ctrl” the
opposite action is performed, and it increases the saturation of the color.

Saturate:  (increment the chromatic level) When you press “Ctrl” the
opposite action is performed, and it de-saturates the color.

Darken:  When you press “Ctrl” the opposite action is performed, and it
lightens.

Lighten:  When you press “Ctrl” the opposite action is performed and it
darkens.

Sharpen:  This accentuates the color definition.  Use “Ctrl” to smooth.

Smoothing:  This reduces the color definition. Use “Ctrl” to accentuate
the color definition.

Increase hue:  Incremental adjustment of the hue.  (use “Ctrl” to
decrement the value). The “Transparency” setting influences the degree
of hue change.

Decrease hue:   The inverse of the above function.

Subst hue:  Substitute the hue in the current layer with the current color
swatch.

Hue&Saturation:  Substitute the hue and saturation from the current
layer with the current color swatch.  For example, paint on an object using
color, then choose the Darken command. Paint again on the object in the
same place to see how your current color darkens. Try different color
operation modes, as this function is highly dependent on the color
channel’s transparency.
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Magnification or reduction of Layer
height:  Choose the operations on the Layer
height (increase or decrease). When painting,
it is only the current Layer height that is
changed. Press “Ctrl” to perform an inverted
operation. When using this tool, both “E”
panel functions and the selected Material
are taken into account.  Use the “Degree of
change” slider to limit the amount of change.

Shift Layer in tangent space:  This tool lets you smudge, collapse and
expand the area under your brush. All operations will be applied in

screen space, so you should try to center the area to be modified in the
best view position. This tool is intended to move only small details in the
Layer.

NOTE:  You must click the LMB to apply the last two operations.

Clone Brush:  This tool can also be considered a “Texture Adjustment”
tool, and it has quite a few options for use, so please read and test it out

carefully to learn more about it.
Press “Ctrl-LMB” to mark a source point for copying, then paint using the
LMB. You can clone your texture, not only with a standard Brush Alpha,
but also with the frame and contour Brush functions - (press “E” for Brush
functions). There exist a number of methods for cloning:

Translation:  In this mode, press “Ctrl+LMB” to select the source point.
Dx:  The horizontal shift of source point.
Dy:  The vertical shift of source point.

Mirroring:  Copying with mirror-reflection of a plane.
Press “Ctrl+LMB” to select the point for the plane to
go through.

Inversion:  Copying with inversion against the point.
Press “Ctrl+LMB” to mark the center point of inversion:
Center X and Center Y – positions of pivot point on
screen. Press “Ctrl+LMB” in the corresponding places to change it.

Clone sector:  Copy a sector rotated at a selected angle against the pivot
point. Press “Ctrl+LMB” to mark the rotation center point. This mode can
be used to multiply a pattern drawn in one sector all around. Center X and
Center Y are the positions of the control point on the screen. To change its
position, press “Ctrl+LMB” in corresponding place.

Number of sectors:  Number of sectors when cloning a pattern in a
sector.

Counter clockwise:  When enabled, the sector will be copied counter-
clockwise.

Symmetrical copy:  Symmetrical copy lets you to copy a
surface from one side of a model to make it symmetrical.
Press “S” and activate symmetry before using this tool.
This tool can be used on any of the three axes to copy
symmetry. (Image left)

Copy using Brush:   This lets you copy using topological
symmetry. You should set up topological symmetry before
using this tool. Topological symmetry can be defined in the Topological
symmetry tool by selecting two symmetrical faces.

Transform/copy tool:  Drag the frame and select an
area to be transferred. The frame acquired can be
dragged, or rotated. Use “Shift” to preserve proportions.
Use “Ctrl” to drag vertices independently of each other.
Press “Esc” to cancel the transformation and “Enter” to
apply it. This mode is good to use in combination with
the Rectangle, Circle and Curve painting methods
(press “E” to open the draw types menu). The border width determines the
edge softness when transforming. By disabling channels (Depth, Diffuse,
Specular) you can limit the channels that are affected. In the transform
mode the surface area is erased from its old
location and copied onto the new one.

In order to simply copy without deleting, do not check the “Erase old
position” option. It is possible to transform whole block of visible Layers
and paste them merged or separately. You can select what to copy, not
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only with the Rectangle tool, but also by using the freehand selection tool,
and others. The options for this tool are as follows:
Depth modulator:  Additional depth modulator for the transformed area.

Opacity modulator:   Additional opacity for the transformed area.
Specular modulator:  Additional specular modulator for transformed
area.

Export:   Export selection to a .PSD file.
Import:   Import a selection from a .PSD file.

Edit:   Edit image with an external editor that supports .PSD files. By
default it is Adobe Photoshop.

Save:   Save transform parameters and image to InstallDir\User-
Data\StoreData\Rects\
Load:   Load transform parameters.

Copy/Paste:  You can copy parts of a surface to the clipboard by using
CTRL+C and then paste them using CTRL+V. If the cursor is not on an
object, it will be pasted to the same place it was copied from. Images in
the clipboard can be edited in another graphics editor, then copied back
to the clipboard and pasted onto the object surface. If the color channel is
open for editing, the color texture is placed into the clipboard; if it is
disabled, then the depth texture will be placed into the clipboard; in case
the depth is disabled for editing, then the specular texture will be placed
there. Hence, you can copy and edit in a different graphics editor any of
the channels depth, color or specular. If you press CTRL+SHIFT+C a new
pen is made from a surface part and added to the pen list. When you press
CTRL+SHIFT+V the mirror reflected part is pasted. Bear in mind that
copying and pasting are pen-turn sensible. Copying and pasting objects
with the help of hot keys is not limited to Copy/Paste tool, but is possible
in any other mode.

Save:  Save the clipboard image into a file.
Load:  Loads the clipboard image from a file.
Using these functions, you can create a library of

stamps. Load a plane or a cube, for example, draw a button or a rivet, then
save it to a file. As with depth, so the color and specular will be saved, too.

Paint with Splines:  Upon activating the tool, the Parameters Panel
will be activated. There are many parameters for the curve tool:

Curve profile:  First let’s take a look at the Curve profiles.

� Uniform. The curve with no linear modulation.
� Sharp. The curve sharp on edges.
� Obtuse. (flatten) The curve flattened on edges.
� Arrow.
� Arrow back.
� Double arrow.
� Arrow.
� Back arrow.
� Double arrow.
� Arrow.
� Back Arrow.
� Double arrow.
� Sinuous.

Ignore back faces:  When this option is activated, you paint only on the
visible part of the surface.

Closed curve:  Closes the curve.

Use spacing:  Points will be set along curve with some spacing and jitter-
ing. It lets you make new effects with curves.

Toggle hardness:  This mode lets you toggle the hardness of the spline
vertices by clicking on he vertex. Pressing “Esc” cancels this mode.

Profile parameter:  This parameter affects the linear curve profile in case
you selected the sharp or obtuse profile.

Depth modulator:  Modulator, impacting the entire curve depth.

Width modulator:  Modulator, impacting the entire curve width.

Opacity:  Transforms the current combination of points to a circle if
possible.
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To line:  Transform the current set of points to a line if
possible.

Subdivide:  Subdivide curve.

Equalize:  Set equal distances between points.

Store:   Save curve to a file with *.curve extension,
placed into:
InstallDir\UserData\StoreData\Curves\ by default.

Restore:   Load curve from a file with CURV extension, located in:
InstallDir\UserData\StoreData\Curves\ by default.

Moving the whole curve:   Use the 3 icons on the right bottom of
Parameters Panel menu - You can rotate/move/scale the entire curve.
NOTE: You can use “Ctrl” while dragging a point to rotate the whole
curve and you can also use “Shift” while dragging a point to move the
entire curve.

Paint a spline by Left-Clicking to position a few points. Hovering the
cursor over one of the blue dots causes it to highlight.
Left-Clicking captures the point and allows you to drag
it into a new position. Click again to release the control
point.

Splines are handy used together with Strips to carefully
paint a chain or a series of rivets. Clicking “Enter” applies
the spline to the object. Left-Click to add new points to
the spline. Pressing “Enter” to complete a curve produces
a raised element - while completing the spline with

“Ctrl-Enter” indents the curved elements.  Use
“Backspace” to delete the last point and “Esc” to delete
all points.

Curve Profile:   There are many curve profiles, you are
encouraged to test them all out.  They range from arrows
to rounded ends, but of course there are many more.

Use spacing:   Points will be set along the curve with
some spacing and jittering.  Spacing combined with
the various “Jitter” options can create a wide variety of
effects. Curves will be drawn correctly, even if their
knot points are far from each other and the surface
between them is quite curved.

With the “Paint with Splines” tool, you are not only able to paint and
extrude/intrude, but you also can do the following:

Erase:   Erase the current Layer along the curve.

Freeze:  Freeze along the curve. “Ctrl-Enter” to unfreeze.

Make Planar:   Flatten the surface along the curve. Set absolute height.
Apply the plane tool along the curve and then apply the usual extrusion.
This sets the absolute (not relative) depth along the curve.

Painted Text Tool:   Using this tool you can
select the font for text, input the text so as to
change the parameters of the curve the text is
applied along.  Use the following options with
this tool:

Ignore back faces:  When this option is
activated, you draw only on the visible parts of the surface.

Closed curve:  Draw a closed curve.

Flip text:  Flip the whole text.

Depth modulator:  Modulator, impacting the entire curve depth.

Width modulator:  Modulator, impacting the entire curve width.

Opacity modulator:  Modulates the opacity of the entire curve.

To circle:   Transform the current set of points to a circle if possible.
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To line:  Transform the current set of points to line if possible.

Subdivide:  Subdivide the curve.

Equalize:  Set an equal distances between the points.
Toggle hardness:   This mode lets you toggle the hardness of the vertex in
a spline by clicking on the vertex. ESC cancels this mode.

Save:  Save text and font in a .txt file, placed into InstallDir\User-
Data\StoreData\Texts\ by default.

Load:   Load text from a .txt file, located in InstallDir\UserData\
StoreData\Texts\ by default.

Add new points into the spline by “Left-Clicking”. Use “Enter” to apply,
with depth - upon applying, the text will be extruded outward over the
curve.  Pressing “Ctrl-Enter” indents the text into the object. Use

“Backspace” to delete the last point, “Esc” to delete all points.  Click on a
blue sphere to move it. Painting with text along a curve allows you to
paint and extrude, as well as letting you Erase/Freeze/Make Planar/ Set
the absolute height. You can place text along any polygonal surface and
along any contour.

Place Image Along Spline. You can apply an image along a spline
curve with this tool. You can select the images used for Depth
texture/Color texture/Specular texture to tile along a spline. There are
several settings and functions:

Number of tiles:  Specify the number of tiles. A lower
number produces fewer tiles.

Falloff:  Opacity falloff.

Extrusion:  Extrusion of the whole texture.

The other parameters are the same as used with
“Paint with Splines”. With the “Place Image Along
Spline” tool, you also can Erase/Freeze/ Make

Planar/Set absolute height. Here is an example of using an image along a
spline to freeze an area.

Erase:  Erasing the Color, Depth or Specularity in the current Layer.
Eraser intensity depends on the slider for Eraser transparency.  Erasing
only effects your currently active Layer.

Hide:  Hides selected polygons.  “Left-Clicking”
with a Brush hides parts of the surface by painting

on the model. Pressing “Ctrl”shows previously
hidden surface areas. Use “Ctrl-X” to unhide all.

“NUM+” or “NUM-” makes the hidden area wider or
narrower.

Hide Parameters:  Using the additional Hiding menu you can
save/load hidden areas as presets. In these instances you will
also have a drop-down list so that you can select between these
presets.

Hide Menu:  Additionally, you can access the more advanced functions of
the Hide tool in the main menu in the “Top tool bar”. For convenience, you
can also undock this menu (like any other menu) and place it in an easy to
access area. With this menu, you are not only able to hide surfaces by
painting on the model, but you also can hide the
whole object by selecting the object you want to
hide. For example, if there are several sub-objects
in the scene, you can use “Hide Sub-Object” to hide a specific object, as in
the picture below. If there is only one object in the scene, “Hide Sub-Object”
will hide only that object. You can also hide faces by their specific material,
use “Hide Material”. Select one material from this menu and all the surfaces
with that material will be hidden. The other commands are self-explanatory.

Freeze Surface tool:  This is a mode of freezing surface parts to
prevent their subsequent change. Freeze mode can be conditional, for
example for relief, flat or colored parts depending on mode selected.
Blocking masks the action of feathering. Freeze mode is an operation
opposite to selection.  Press “Shift” to smooth out the edges of blocking.
This drop-down list provides the various Freeze modes. When the Brush
goes along the surface, it gets masked in accordance with the condition
you choose in this menu.
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There are five masking modes in total:

Freeze all:  Mask with a touch of the Brush or
 mouse-click (default mode).

Convexity:  Mask the convex parts of the surface.

Concavity:  Mask the concave parts of the surface.

Not key color:   Mask all, except the color currently
 selected.

Key color:   Mask the color currently selected.

There are three sliders on the top bar for the freeze tool:

Contrast:  This parameter increases the freezing contrast.

Smoothing degree:   Sets the smoothing level of the freeze area.

Freeze degree:   Controls the level of the opacity of freezing. Masking
 can be saved to a file and loaded. In this way you can create a set of
 handy masking outlines for your model. If you saved at least one file,
 subsequently, you will have a drop-down list offering a selection of
 files. Of course you can also access many more  options for the Freeze

tool in the main menu of  the top tool bar.

Freeze the surface:   Freeze all the surfaces with the current condition.
Invert freeze/selection. The frozen surfaces will be

unfrozen and the surfaces
which were not frozen will
be frozen.

Toggle freeze view:  There
are six modes with which
you can view the frozen area.

Many of the other commands are self-explanatory as well, and you are
strongly encouraged to explore each one.

Fill Tool:   If you are familiar with the fill tool in Photoshop or other
photo-editing programs, then you should be quite familiar with this tool
already. It lets you fill in self-contained areas based on a number of
parameters you can specify. There are three main parameters by which
you can fill:
Layer:   Fill the whole Layer.

Material:  Fill the material of the object.

Object:  Fill the sub-object.

There are sub-options for this tool as well, that
you can use with each of the three main filling
methods:

Use color tolerance:  This lets you fill in your color
or material based on its “closeness” to another

color. By using the slider you can adjust this value. The higher the tolerance,
the larger area and/or more existing colors it will fill.

Fill with freeze:  Instead of a color fill-in, the surface will be filled by
freezing. The Freeze degree slider is responsible for maximal freeze values.

Lines mode:   Lets you fill-in by setting two points. The vector between
them is considered the main direction when using distortions. If you have
chosen the Fill with gradient, the surface will be filled with color gradient
from the main color to secondary one. Otherwise, the main color is used
for filling-in. If the pen radius differs in the starting and final point of the
line, then the modulation scale will smoothly change from the start to the
final point. You can use gradient filling in the fill tool in a much more
intuitive way.

Modulation type:   In case the “Use with other tools” option is selected,
the modulation acts not only in the “Fill mode”, but with the standard
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Brushes too. There are are number of basic and
user-adjustable types of modulation available:

No modulation:   Filling will be done without
additional modulation.

Noise:   Random noise.

Gaussian noise:   Random modulation with
Gaussian noise applied.

Wavy surface:   Wavy surface y=sin(x).

Stripes:   Stripes that are perpendicular to the main axis.

Saw:   Saw-tooth shape.

Hexagon:   A correct hexagonal grid will be used as the volume texture
when modulating.

Random spheres:   Space filled with random spheres will be used as the
volume texture when modulating.

Pores:   Generation of pore-like surface.

Spots:   Generation of “pimpled” surface.

Fractal N1:   Volumetric Perlin noise.
Fractal N2:   Square of Perlin noise.
Fractal N3:   Perlin noise limited by planes.
Fractal N4 (cracks:   Resembles cracks.

Fractal wood N1:   A set of distorted planes perpendicular to the view
direction.

Fractal wood N2:   A set of distorted cylinders. To set the cylinder axe, go
into the lines mode.

Fractal tree N3:   Wood with knot imitation. Contents

Custom:   Rough skin.

Add custom:   This lets you create your
own custom modulation type.
Depending on the modulation chosen in
the “Modulation type” menu you will
have the ability to adjust a number of
parameters for each one. They are as
follows:

Peak position:   The position of
maximum.

Scale:   Scale of modulation.

Anisotropy:   The degree of stretching or compression of details along the
direction selected. If no direction is set, then it is a vertical axis. Switch into
the lines mode to specify the direction.

Width of jag:   The relative width of jag.

Pores size:
Spots size:
Cracks width:

Edge contrast:   This parameter determines the smoothness of the edges
in cube mapping.

Bump texture:   The bump texture to be used in cube- mapping.

Color texture:   The color texture to be used in cube-mapping.

Name:   The name of a custom pattern.

Delete pattern:

Modulate depth:   Select this point if you want to modulate the depth
when filling. The parameters are as follows:
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Depth modulator:   Modulation value.

Extrusion:   The addition extrusion. “-1” means that the surface will
 only be indented,  “1” –  only extruded.

Modulate color:   Select the corresponding color operation and paint
with it. Vary the opacity to make the effect stronger or weaker. These
parameters are listed as follows:

Color preference:  This slider determines the preference of color use
 between color for convexity and concavity.

Convexity opacity:   Convexity opacity modulator.

Convexity color:   This color corresponds to convexity.

Concavity opacity:   Concavity opacity modulator.

Concavity color:   This color corresponds to concavity. Contents

Modulate specular:   Select this option if you want to modulate specular
channel. These parameters are as follows:

Convexity specular:   Convexity specular modulator.

Concavity specular:   Concavity specular modulator.

To apply the new fill pattern you should specify a texture for the Bump
channel and a texture for the  Color channel (optional). They will be mapped
on an object using cube mapping with soft edges. The screenshot to the
right shows the difference between usual cube mapping and mapping with
soft edges. In this way, you can texture objects seamlessly, with ease. It is
easy to create materials like skin or pores with this method.
Save/Load fill parameters:   Using the menu “Store/Restore” you can
store parameters of the Fill to file, located in “InstallDir\User-
Data\StoreData\Fillers\” folder by default.

Here are a few things that are worth noting about the Fill tool. You are not
only able to use the Fill tool separately, but also in combination with other
methods. For example, we can use the Fill tool in combination with a
Material. In the picture at right, we have filled in a certain area with a
Material, using the cubic mapping
method. On the edges we created freeze
areas, while the inside area was filled in.
Pay attention when lines modes and Fill
tools are used in combination, you can fill
closed spaces with a color gradient.

Another thing to note is that if your fill
area is very large, you may get a warning prompt from 3D-Coat letting
you know that it may take a while to fill. If that does happen, please be
patient! The application hasn’t frozen - just calculating.

Eye dropper:   Pick the Color and Specularity from the surface of an
object. Use the hot key “LMB-V” to pick the primary color and “RMB-V” to
pick the secondary color outside this tool. Use “H” to pick the top Layer.
Use “G” to pick the depth of the Brush.

Make planar:   This tool flattens the geometry on the object. Use the
LMB to make the surface inside the Brush cursor flat. The Brush shape is
stored. By choosing the “Smoothing” command, the advanced Plane tool
menu with a set of options opens:

Normal source:   This option determines if the normal and point of
 the  plane should be taken from the first click position or from the
 current  point.

Plane extrusion: Lets you make additional extrusions while making
 the plane. It works like a clay brush.

Make planar:   Makes the surface planar.

Cut off:   Cut off parts above the plane.

Fill mode:   Fill holes below the plane.
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Topological symmetry tool:

Topological symmetry lets you copy
surface pieces if they have a symmetrical
face structure - even if they are not
symmetrical geometrically.  Select the red
face with a “Left click” and then select the
blue face. It is better if they are adjacent.
Either way, the contents should be
symmetrical to each other.  This lets you
define the topological symmetry. The
settings for this tool are as follows:

Work mode:   Lets you choose between two modes: setup symmetry
 by picking two symmetrical faces or copy from one side to another
 using the Brush.

Copy red to blue:  Copy the red part of mesh to the blue one. You
 should define them before using this tool.

Copy blue to red:  Copy the blue part of mesh to the red part. You
 should define them before using this tool.

Flip Layer:   Flip Layer using topological symmetry.

Copy freeze mask:   This is pretty self-explanatory. It lets you copy a
 freeze mask from one side to another using the topological symmetry
 tool.

Save:   Store symmetry state to .SYMM file.

Load:  Restore symmetry state from .SYMM file.

Measuring tool:   This tool lets you measure distance between two user
specified locations. Here are the parameters:

Original mesh units:   You can define the units of measurement and
 measure line length.

Units to display:   You should choose the units to display. There are
 parameters in these combo boxes: Meters (m), Millimeters (mm),
 Centimeters (cm), Kilometers (km), Foots (ft), Inches (in), Yards (yr) and
 Miles (mi).

Scale:   The scale can be used to transform units. Usually you don’t
 need to enter this value manually.

Length:   The length of the red line.

7.0 Ptex

Ptex is one of the more
amazing technologies,
allowing you to paint
extremely high resolution
textures on a per polygon
basis, as well as completely bypassing all UV work - as it does not require
any manual input for the creation of the UV maps. Ptex, in it’s current
implementation, only supports quad polygons, no triangles or N-gons.

It’s important to note that when using Ptex in 3D-Coat, you can
increase the resolution of individual polygons if you require more
texture details in the local area of that polygon.  By increasing the
resolution of a polygon, or group of polygons, it is effectively increasing
the size of that polygon on the auto generated Ptex UV map.

For example, you could paint very small details inside of areas on a mesh
which calls for an extreme close up shot or just requires more detail in one
particular area - yet, you don’t want to create a lot of very high resolution
texture maps.  Ptex works quite well for this purpose.

What is even more remarkable is that the .ptex format can store hundreds
of thousands of textures directly with in one .ptex file. At this time, only
external application that supports the .ptex format will be able to
import/export the .ptex file for use.  To fill in this gap in .ptex support, we
have provided for the export of an ordinary texture map, based on Ptex
technology, in the .TGA, .BMP,  and .PNG  formats.

Upon importing a mesh for Ptex painting, you will be prompted to select a
number of options:
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Millions of polygons:  This is the mesh resolution as sub-divided after the
“Smooth object” operation is performed. This
should be higher than the number of pixels
of your texture map.

Carcass resolution:  This is the mid-poly
resolution, it only effects the viewport
performance and display of the mesh in the
viewport.

Ptex Texture Size for Export:  You can select a texture resolution
between 512x512 and 8192x8192. You can also change this at any time
you need to scale up or down your texture resolution.

Weld vertices:  This will weld any vertices which share the same position.
Swap Y and Z. This will swap the Y and Z axes. This allows for an easier time
when bring meshes from applications such as Rhino or 3DSMax. Ignore
smoothing groups. Ticking this will ignore any smoothing groups which
you have on your mesh.

Invert normals:  This will flip the normals of each polygon.

Auto smoothing groups:  Will automatically scan the mesh for sharp angles
between polygons, and apply smoothing groups to them automatically,
maintaining any sharp edges that are present. Each of the following Ptex
functions requires a selection. To make a selection, simply activate the Ptex
Local Resolution tool and “paint over” the polygons in the viewport.

Local Resolution parameters:

Clear:  Clear any selection.

Invert selection:  Invert your
selection.

Expand:  Expands your selection by one contiguous polygon.
Contract:  Contracts your selection by one contiguous polygon.
Select level:  Manually key a local polygonal subdivision level.

Increase resolution:  Increases the local resolution of the currently
selected polygons. This effectively increases the polygon size on the auto
generated Ptex UV maps.

Decrease resolution:  Decrease the local resolution of the currently
selected polygons. This effectively decreases the polygon size of the auto
generated Ptex UV maps.

To max level:  Sets your current selection to the maximum level allowed
for Ptex. Effectively increasing selected polygons nearly taking up their
own UV map.

To min level:  Sets your current selection to the minimum level allowed
for Ptex. Effectively shrinking selected polygons, allowing more polygons
per UV map.

Ptex Texture Size:  You can pick the texture resolution for each ptex
generated texture. Selectable resolutions range from as low as 512x512 to
as high as 8192x8192. You can change this at any time to suit your needs,
as well as upon importing the mesh for ptex painting.

Optimize:  Organizes polygons on every auto generated Ptex UV map to
fit more polygons, based on local resolution (poly size per UV space).

NOTE: When using this, do keep in mind that if you have been using a mesh
with specific auto generated Ptex UV maps, it will completely reorganize
the polys on all UV maps, rendering your previous auto generated UV maps
useless. However, you can always bake the details from one mesh to another.
Just be sure to save two meshes: Your
original and the baking target mesh.

For more information on Ptex, please
visit the official Ptex website at
http://ptex.us/
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8.0 The Sculpt Room

The Sculpt Room and its tool set are 3D-Coat’s equivalent to
what other applications refer to as “Polygon Sculpting”.
Different from Voxel Sculpting, Polygon Sculpting simply
allows you to move, deform and shape the surface of your
object - (whereas Voxel Sculpting deals with the entire volume
of an object). The Sculpt Room can only be used after a
topological mesh has been created, either with an external
polygon modeling application -  internally, with manual
Retopo tools - or with our own automatic topology tools
(AUTOPO).

The Tools

Move:   Drag the surface under the brush cursor. Use CTRL to drag along
the average normal.

Select/Move:   Select surface parts and modify
them (move, rotate or scale). The available
parameters for this tool are as follows:
Select with Brush or rectangle:

Select with Brush, rectangle or curve:  Use CTRL
to subtract a selection, SHIFT to add a selection.

Select with gradient:   Selection is done with a gradient. Click to
determine the start position of the gradient and then click again to
determine the end point.

Select objects:   Select the whole object with LMB.

Move:   Move the selected area.

Rotate:   Rotate the selected area.

Scale:   Scale the selected area.

Smooth:   Smooth selection.

Expand:   Expand selection.

Clear:   Clear all selections.

Widen:   Make the intermediate area of a selection wider.

Contract:   Contract selection.

Increase:   Raise selection value by 10%.

Save:   Save the selection to a file.

Load:   Load a selection from a file.

Drag Dots:   In this mode you can
add control points and drag them
to new positions, thus “morphing”
the affected area of the mesh.  The
size of the Dot determines the
region of influence over the mesh.  (Rotation and Scaling can be performed
also). Use the “Delete” key to delete a selected Dot. Select several Dots
simultaneously using the “Shift” key. The available parameters for this tool
are as follows:

Move:  (Hot key SHIFT+”W”):  Move the selected area.

Rotate:  (Hot key SHIFT+”E”). Rotate the selected area.

Scale:  (Hot key SHIFT+”R”). Scale the selected area.

Delete all handles:

Edge hardness:  Increase this value if you want to transform more of
 the  hard-edged polygons.

Show selection: Show which selection corresponds to the selected
 Dot.
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Save:   Save the handle positions to a file.

Load:   Load the handle positions from a file and add the handles to
 the  existing handle array.

Paint:  Paint with pen. Use CTRL to cut into and SHIFT to smooth the
surface.

Collapse:   Collapse a part of the surface. Use CTRL to expand the surface.

Expand:   Expand a surface part. Use CTRL to collapse.

Shift:   Shift the surface along pen motion in screen space.

Tangent Shift:   Shift the surface along pen motion in normal plane.

Smudge:  Smudge along the surface under the pen.

Flatten: Flatten the surface under the pen.

Smooth:  Smooth the surface with the pen.

9.0 The Retopo Room

3D-Coat offers the most powerful set of retopology tools in the 3D
industry. These tools let you quickly and easily change the existing
topology of a model. 3D-Coat can be used purely as a retopology
tool. Just open a reference mesh and start retoplogizing it by
covering it with new polygons. If the reference mesh is textured,
3D-Coat will be able to bake not only the geometry but also all
texture maps onto the new topology.

Tools & Commands

This tool section lets you create new topology for any existing mesh.
Each tool in the retopology section will be covered here, as well as
most of the commands for each tool.

Add/split:   This tool lets you simply add edges by
pointing and clicking in the location you would
like to add the edge.

Select:   This tool has three primary modes,
allowing you to select Points, Edges and Polygons. Each of these modes
has further functions.
They are as detailed for Points (these are also the general commands for
most of the other tools):

Import:   This lets you import a mesh for retopologization.

Export:   This lets you export your retopologized mesh in .OBJ, .LWO,
 .STL and .PLY formats.

Snap:   This snaps the retopologized mesh to the underlying mesh, if
 you have modified the underlying mesh in anyway.

Subdivide:   This tool is self-explanatory. It subdivides the mesh. For
 example, each polygon is divided by 4.

Clear:  This will clear the retopologized mesh in the scene.

Relax:   This relaxes the current retopologized mesh.
  selection of edges.

Delete:   Point and click to delete edges.

Edge loop:   Quickly add an
edge loop, by hovering over edges to get a preview. Use the LMB and

 clicking to add the edge.

Edge ring:   This is the same as Edge
 loop, however it runs  perpendicular
 to the direction of the edge loop
 function.

Delete:   Deletes selected polygons. You can also achieve this by hovering
over a polygon and hitting the DELETE key.
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Subdivide:   This is the same as for polygon mode, or any other subdivide
option in 3D-Coat.

Hide:   This tool makes it easier to retopologize in very tight areas. If you
are running into a problem, simply select the polygons in question, and
hit the hide button.

Invert hidden:   This will invert the polygons you may have previously
hidden.

Unhide:   This will unhide all polygons previously hidden.

Quads:  The basic use of this tool lets you select
an edge of a polygon, and then drag out and click
the placement of the edges for a new polygon.
There are four different methods of use for this
tool, and they are are fairly similar. You are

encouraged to try each one. They are: 2-clicks method, Parallel, Direct
and Trapezoid.

Points & Faces:   This method is quite handy when starting out on your
retopologization. You place points with the LMB, and once there are
qualifying areas to place polygons, you only need to use the RMB to place
the polygons. You will see a blue outline of where the polygon will be placed.
You can move the points by using the RMB to click
and drag it around. You can also delete a point by
hovering over it and hitting the DELETE key. This tool
will only work with tris and quads.

Cap:   With this you can cap any existing hole in
your polygonal mesh by pressing the RMB over it. It will create triangles
only. It is best used for the end of a pointy object, such as the tip of a
sword or spear, pointy ears or tails.

Strokes:   This is a very powerful tool in the retopology arsenal. With it
you can quickly retopologize cylindrical objects such as arms, legs and
other similar items. You can draw lines by clicking and dragging the LMB.
There are a few commands local to this tool:

Clear:  Clear all the drawn lines.

Smooth:   Smooth all current drawn lines.

Delete:  Delete your currently selected line.

Here is a more in depth look at it all. Firstly we’ll start
by making some strokes in the viewport to cover the
whole of this leg. When that is done, a spline will loop
around. We’ll create a few
loops to have some area to
create polygons in.

Next we’ll create a perpendicular line within the
confines of the area of the mesh, opposed to the
previous lines. You’ll notice that line is a green color
instead of orange.

Green lines mean that it is discontinuous. Orange
lines mean that is is continuous and makes a full
loop around to connect back to itself. Now let us
take a look on the top
toolbar, we’ll need to
select a number of
segments. You will get

ring of polygons with corresponding number of
segments. Now we’ll try something a little
different: instead of drawing lines around a mesh,
let us draw a grid look within the mesh, instead of slices as before. Now
press the Enter key and you will have the area you surrounded with the

strokes created as polygons.

Now let’s demonstrate one more method here. We’re
going to draw a circle within
the confines of the mesh, to
create edge loops, or circles.

Then we’ll draw a perpendicular stroke to the circles
that we previously created and then hit the ENTER
key. You’ll notice that it automatically created our
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entire loop based on the Number of segments setting in the top tool bar,
similar as before with the first demonstration we gave for cylindrical objects.
These are just some of the methods with this tool that you’ll soon discover.
You are encouraged, as with all other tools in 3D-Coat, to dive in and find
out what tools and techniques work best for you.

Brush:   This tool lets you move vertices based on your brush size and
intensity, using the LMB. You can also smooth
the vertices with your brush using SHIFT+LMB.

9.1 Tweak & Commands

This set of retopology tools lets you tweak the current retopologized mesh
in the viewport. Please notice that the commands for each tool in this Tweak
section have very similar commands to those listed above in
the Create & Commands section. If there is a unique
command, it will be listed with its respective tool.

Delete polygons:   You can delete polygons with this tool
simply by clicking them. With the CTRL key you can also
delete all connected polygons.

Delete edges:   With this you can quickly delete edges, edge
loops and edge rings. Hover your mouse over the desired
selection and click the LMB.

Collapse:   Hover your mouse over a selected edge and
click the LMB to collapse all connected points of that edge to one location.
With CTRL+LMB to apply this to an entire edge ring.

Split rings:   This is exclusively an edge loop tool. Hover the cursor over
an edge where you would like to apply a new edge loop and click your
LMB.
Move vertices. Also known as a “tweak tool” in some packages, it lets you
quickly move a point, edge, polygon, edge loop or edge ring. Select the

mode you would like to use in the top tool bar, size your brush
accordingly and move around your selection.

Move Vertices:

Slide edges:   Slide a selected edge between its two parallel edges by
clicking the LMB and dragging.

New Select Commands for Edges:   “Extrude” allows for the extrusion of
selected edges, while “Bevel” allows you to specify a bevel of a certain
width to selected edges.

Transform:  New Transform widget for selections.
(New “To Local Space” option)
Delete:  Delete selections
Clone:  Clone selections
Hide:  Hide selections
Invert Hidden: Invert hidden selections
Unhide:  Unhide all selections.

9.2 Retopo UV’s

The UV tools for the Retopo room have been expanded to include every
UV tool from the UV room in 3D-Coat. You can find information on each of
the UV tools inside the Retopo room in the
UV section of this manual.

9.3 Retopo Menu & Tool Bar

Of course any good tool has more to it then meets the eye. The
retopology tools are no exception. You can find the menu in the
top tool bar, under Retopo. Below are listed all of the functions in
this menu.

Import retopo mesh:   Import an external mesh to continue
creating topology started in another 3D modeling program.
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Export raw object:   Export a retopo mesh to continue work in another
3D-modeling program.

Use current low-poly mesh:   A reference mesh can be imported to
retopologize big objects made in another 3D modeling program. They can
contain reference to textures. In this case the objects will be colored; color
will be used in baking and merging into the scene.

Unwrap:   The same as Unwrap in Mark seams mode.

Clear mesh:   Clear the whole mesh.

Subdivide:   Subdivide the whole mesh.

Apply symmetry:   Apply symmetrical mirroring.

Merge into scene:   Lets you merge a retopologized mesh into scene. All
details from the reference mesh will be baked into a new object. Addi-
tional extrusion can also be applied. A UV-set is required, but if you have
not assigned a UV-set it will be generated automatically.

Merge hull in scene:   Merges outer mesh over reference object into
scene. This function works like Merge into scene but is optimized for a
multi-object reference mesh. It prefers outer points while baking surface.

Merge raw patch:   Merge a raw patch into the scene. No baking will be
performed. This command can be used to merge a new object without
projecting details from the reference mesh.

Merge for per pixel painting:

Replace scene with patch:

Bake texture:   Bake texture onto patch. This operation requires a UV-set.

Save retopology state:

Load retopology state:

And we have these items in the top tool bar for the
Retopo tab:
Z-bias:  Adjust the z-bias to get a better look at the
retopologized mesh preview.

Additional extrusion:  You can extrude the
retopologized mesh. This is a great way to make
clothing for your characters.

9.4 Retopology Groups (Layers)
3D-Coat has a Layer system for retopologizing
meshes. This makes it easier to retopologize your meshes with problem
areas and to have multiple retopology versions of the same object.  Much
like all the other Layer tabs in 3D-Coat, they function like the Layers in
Photohop.  You can click and drag Layers to reorder them, drag them to
the Trash icon to delete them, hide & show them with the Visibility icon,
etc.

Let’s take a look at the Retopo Layer tab:

Layers:  As you see in the screenshot, you can have more then one Layer
to retopologize, if you wish. They can be reordered by drag and drop, they
can be dragged to the trash if you no longer need one. Double-clicking a
Layer will allow you to rename it.

Visibility:   Each Layer has its own visibility icon, allowing you to toggle
them on or off.

There are icons along the bottom of the tab as well, and they are:

New Layer:   Creates a new layer.

Trash can:   Deletes the selected layer.

Subdivide:   Lets you to subdivide the whole selected Layer.
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10.0 AUTOPO (Auto Topology)

Manual retopology is great, when you need
a very specific mesh. But what if you don’t
need an exact, extremely precise mesh topology? This is where AUTOPO
comes in.

With AUTOPO you can let 3D-Coat determine where edge loops are
placed. Or, you can manually specify where you wish the edge loops to be,
as well as predefine dense or sparse mesh areas. One thing to note,
however, is that Autopo doesn’t work directly on polygons; Only voxels!
So keep this in mind if you wish to use the AUTOPO tool on a mesh, to do
so, you must first “Merge” the mesh into Voxel space and then apply the
AUTOPO tool.

The meshes generated with AUTOPO can be very clean and functional,
even with little user input for the guides and density painting.

To use the AUTOPO tool, you must RMB click on the particular layer for
which you wish to create automatic topo;ogy - in the VoxTree (which can
be accessed in the Retopo room via the top menu under
Windows>Popups>VoxTree), and select any of the AUTOPO options.

 Doing so will start the AUTOPO “wizard”,
which will run you through the various
options for creating an auto-generated
mesh or a semi-auto-generated mesh
(where you suggest edge flow and local
mesh density).

The first step of the wizard will have you
specify an “Approximate polygon count” of the mesh. After this, a
second dialog appears, in which you can paint areas where you wish to
produce more density in the mesh.

The third and final dialog of the wizard lets you place spline guides upon
the object to suggest where you wish to have the edge loops/flow.  Of
course both the density painting and spline guide topology “suggestions”
are optional, if you wish 3D-Coat to generate a mesh entirely with little input

from the user, AUTOPO produces
surprisingly good topology for organic
shapes.

After the algorithm completes its work,
the mesh will be placed into one of
the various rooms you have previously

chosen to place it into (the Paint Room if you selected a painting method,
or the Retopo Room, if you simply selected AUTOPO with no Paint
method options selected.

11.0  The UV Room

From version 3.2, the UV tools have been
improved, substantially! You can now
edit not just islands with these tools, but
also polygons, edges and vertices
themselves.  There is also now a “Brush”
tool, so you can tweak your UVs to your
liking with the gentle distortion of a
brush, allowing for smoothing and other
quick manual UV techniques.

You may have noticed that the UV tools covered in this section are also
found in the “Retopo Room”.  This is because the Retopo room requires
it’s own set of UV tools for editing “Retopo” meshes.

Note that these same tools are only being defined in this section of the
manual - to eliminate redundancy.

Before unwrapping, you can specify which unwrapping algorithm you
wish to use.  There is the older LSCM unwrapping, and the newer ABF++
unwrapping.  When you mark a new seam, 3DC unwraps new clusters in
real-time and shows you the preview of the unwrapped clusters
immediately - so that you can see the degree of distortion for every part.
Having this convenient function helps to keep you from forgetting the
location of any seam or cluster.
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3D-Coat also supports the creation and editing of multiple UV maps on a
single mesh.

11.1 Modes

Add clusters:   Click the LMB to add a cluster center
directly on a polygon face. Clicking again on the same
face will remove it. This tool lets you “mark” a seam
without actually marking it as one, allowing for a
whole UV island to be split into parts without actually
splitting them.

Mark Seams:   When you are ready to
unwrap your mesh to create a UV map, you
must first of course select your seams. That
is where this tool comes in. You can select
edges with the LMB, edge loops with
SHIFT+LMB and deselect with CTRL+LMB.

Edge loops:  This tool is no different then
holding down SHIFT+LMB with the “Mark

seams” tool. The difference here is that you are not required to hold down
the SHIFT key to select your desired edge loops.

11.2 Commands

Clear clusters:   Clears all UV clusters (also called UV islands) and seams.

Clear seams:   Clears only the seams of the current mesh.

Auto seams:   This function is mostly self-explanatory. It will essentially
create seams automatically with a “best guess” on what edges to select as
the seams.

Unwrap:   Fits all clusters into the UV space.

Pack UV:   This will pack all unwrapped UV clusters onto the UV map.
When this operation is complete, you can then edit the islands on the UV
map. At this point you can perform many essential functions which
require a UV map.

Update Islands:   When you have an existing island, and further mark a
seam on that island causing it to become two, you will need to perform
the Upd. Islands command to carry that information to the UV Preview
Tab so that you will then have those two UV islands selectable, in the UV
Preview Tab.

Apply UV-set:   Clicking this will apply the currently defined UV set to the
current mesh.

Save/Load:   You can also save and load seam and cluster information of
the current scene so it can be edited later. Note that this does NOT export
or import a UV map.

In addition, advanced tools for editing your UV maps directly reside in the
“Selected” portion of the of the retopology tools. These tools all require a
selection in the UV Preview window. To select a cluster (or island) simply
click on one with the LMB.

11.3 Selections

Clear:   Clears the selection.

Invert:   inverts the selection.

Rotate CW:   This will rotate the selected island clock-wise.

Rotate CCW:   This will rotate the selected island counter clock-wise.

Flip U:   This will flip the U of the UV map.

Flip V:   This will flip the V of the UV map.

Relax:   Applies a light smoothing across the selected cluster (or island) to
relieve stretching or pinching.
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UV Preview Tab:   Inside of the UV preview window you can also
manipulate your UV islands & more directly. By clicking the LMB
on an island, you’ll then see a manipulator gizmo.  Selected islands will
then highlight all edges of it’s respective polygons inside the 3D viewport.

UV Preview Manipulator:
This manipulator lets you scale, stretch,
rotate and translate whichever cluster you
currently have selected. You can manually
place your clusters as you see fit before
packing them into a UV map. You must have the “Manipulator” tick box
turned on to use this. It can be used Vertice, Edge, Poly & Island modes.

In the block selected you will find a set of commands that are related to
the selections made in the UV preview window. After applying the
Unwrap command you may want to edit UV island in the UV preview
window.

In the top panel you can choose selection types: Vertices, Edges,
Faces, Islands, Brush and Tweak. Select vertices, edges or faces
(depend on what type have you chosen) with LMB. If you hold
LMB and drag the mouse you can select several vertices/
edges/faces. Use SHIFT to add an item to selection, use CTRL to
subtract an item from selection. Depending on selection type
operations in the Selected block may change.
Vertices Mode. Lets you Clear, Invert, Rotate CW, Rotate CCW, Flip
U, Flip V and Relax.

Edges Mode:   In Edges selection mode there are a few new tools. They
are: To line, Equidistant, Horizontal, Vertical.  The following tools are for
edges mode:

Select Edge Loop:   You can select an edge loop by double-clicking on an
edge or you may simply use an Edgeloop command in the Selected block.
With Edgering command you can select edge rings.

To Line:  This command places all selected edges along the line.
Equidistant. This command places all selected edges along the line
andsets equal distance between points.

Horizontal:  This command puts all selected edges horizontally.

Vertical:   This command puts all selected edges vertically.

Set seams:   This command marks selected edges as seams.

Del seams:  This command unmarks selected seams if there are such.

Faces Mode:  This selection mode differs from Vertices selection mode in
four additional commands: Hide, Inv. Hidden, Unhide, Unhide all. Use this
commands to show only selected faces in the viewport. All other
commands work the same as for Vertices.

Islands Mode:  This selection mode lets you operate with separate UV
islands. You can translate, rotate and scale (vertically, horizontally and
proportionally) an island with the help of Manipulator.

NOTE: that you need to activate the manipulator on the top bar. Check
the Select and Manipulate check-boxes. Also, Keep the Select check-box
always checked unless you don’t want to select anything.

Unwrapping Methods:
These commands are important,
as any mesh you create will need
to be unwrapped if you wish to
paint a texture, or do any such
work. They are listed, as follows:

ABF (Angle Based Flattening):  ABF is a newer unwrapping method and
is better used for organic meshes.

LSCM (Least Squares Conformal Maps):   Meshes in 3D-Coat are
unwrapping with LSCM by default. This method is also used for organic
meshes, but unwraps inorganic meshes quite well too.

Planar:   This projects across the arbitrary axis, so you may use it if you
need.
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Brush mode:  In this mode you operate with the brush which size and be
changed by holding RMB pressed and moving the mouse aside. With the
LMB click and drag you can manipulate the mesh under brush. Use
SHIFT+LMB to smooth the mesh. Use CTRL+LMB to pinch the area under
the brush. Use SHIFT+CTRL+LMB to expand the area under the brush.

Tweak:  It lets you drag vertices, edges or faces around in a very easy way.
Simply move the cursor over a vertex/edge/face until it becomes
highlighted and then drag it with LMB.

Checker Options:  The mesh can be displayed in one of three ways: with
no checker, with simple checker, with complex checker.

Multi-UV Support:   Another drop-down list on the left of the top bar is to
choose a UV-set list. If the mesh has a multiple UVs you can switch them in
that drop-down list.

Overlapping Uvs:   You can have
overlapping UVs within 3D-Coat with no
problems occurring.
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12.0 The Voxel Room

What are Voxels?

Voxels are the 3D version of pixels, in a nutshell.  A pixel is represented by
a square, having the same height and width - and having a specific size.
Given any 2 dimensional area, this area can only contain a set number of
pixels.

Voxel is a new word that really stands for
“volumetric pixel”, since it has depth, as well
as height and width.  Mathematically, voxels
are numerical values [0..1] placed in a cubic
grid. The object’s surface is located where the
value is equal to 0.5.

Like pixels, voxels have the same width and
height - but also have dimension along the
typically “z” axis - which is the same as the

distance for its height and width - in essence, a voxel is a cube - floating in
an invisible mass of voxels which occupy an infinite volume of space.

For any given 3 dimensional volume, there can
only be a set number of voxels occupying this
space.

In a black and white painting program, “paint” is
applied to a given area by giving any number of
invisible pixels, occupying that area, a value of
black or white - (a pixel is either “on” or “off”) -
thus making it appear that some of the area is

“empty” while other parts are painted - like black
paint on white paper.

In a voxel program, painted “volume” is applied to empty space by giving
any number of invisible voxel cubes an “on” or “off” value - which
produces the impression of a 3 dimensional shape floating in empty
space - some cubes are turned “on” while others are turned “off” (some
represent occupied space and some represent empty space).  An

additional benefit of voxels in 3D-Coat is their
ability to be assigned a color and a “material” or

“shader” (giving the additional illusion of some
real world or “other wordly” substance).

For the user, this experience simulates working
with a solid or semi-solid material (like clay or
molten wax) by means of functions that mimic

the use of real world sculpting tools.

Nearly every other 3D-sculpting program is polygon-based, which means
that they work only with the surface of 3D objects -- they manipulate a

“skin” which has no thickness. But voxel-based sculpting programs work
with the volume of 3D objects -- they manipulate a kind of “solid mass”.
This approach lets you sculpt without any topological constraints: it lets
you build up complex objects from “nothing” and to endlessly add and
subtract volume “mass” -- and easily punch holes in the objects. This
approach gives you total freedom in your 3D sculpting.

With voxels, you can work like an old-fashioned, real-world, clay-based
sculptor -- one who never needs to think about dreary technical things
like polygons and topology and who, therefore, can just freely and easily
express himself.  If you need to sculpt an ear, an arm, or a leg, simply start
putting together lumps of digital clay!

As fantastic as voxels are, you should also understand some of the
limitations of this technology.  For instance, objects can’t be extremely
thin in a voxel form. If you want to make a very thin surface, like cloth, you
need to increase the resolution of the voxel object to avoid the
appearance of 3D “jaggies”.

A more convenient way to work with very thin layers of
voxels is to use the new “Surface Mode” for voxels. This can
be done by clicking on the Cube icon next to the particular
Voxel Layer you would like to work on -- and cube icon will
then change to a wavy line. The wavy line icon tells you that
you have entered the Surface mode.
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12.1 Voxel Sculpting Tools

When you’re in the Voxel Room, there are a robust set of tools that you
can use for sculpting and to perform different operations. They are
located on the left-side tool panel. You can always obtain access to the
Voxel Tool Panel by pressing “Spacebar” anywhere on the screen. As with
any other panel, you can pin it for your convenience.

Grow:   Increases or decreases the surface
beneath the cursor. None of the Brush Alphas
having any effect on “Grow” - just the brush
size and the intensity. Press “LMB” and move
the mouse to produce an expanded section.
CTRL+RMB to produce a contracted section. On the top panel, the “Growth
power” slider controls the intensity of the expansion and the “Thaw power”
slider controls the intensity of the contraction.

Fill:   Fills any cavities or voids that you apply the brush to. Its action is
similar to the “Smooth” tool, but more precise.  It’s useful when you want
to make cavities shallower,  but not fully level with the rest of the surface.
It sometimes requires very high intensity settings to fill areas.

Clay:   Lets you blend expansive strokes quickly
on the surface of your model.   It will also
simultaneously smoothes the surface after
you’ve applied it.

Carve:   Lets you place high peaks and deep gouges quickly on your
model, but with no smoothing.

Airbrush:   This tool provides a very controllable way to add volume to
your model.  Unlike the Clay tool, it constantly grows underneath your
brush as you press the LMB, regardless of mouse or stylus motion.

Build:   This tool is similar to the “Grow” and the “Airbrush” tools.  But
while the Airbrush will continue to build while holding down your cursor,

“Build” doesn’t do that. You have to move it, like the “Grow” brush.
However, with the Build tool you can determine the Brush interaction by
means of the Brush Alphas (no smoothing is applied).

Extrude:   This tool is very similar to the Carve tool, but it includes intense
smoothing.

Sphere:   This tool is a very quick way to create bubbles, bodies, eyeballs,
etc. The size of the sphere is dependent on the size of the brush. You can
also make it dependent on stylus pressure: click on the icon near the
Sphere extrusion slider. The maximum size will be the maximum size of
the brush. You can create separate spheres and long, “pill-shaped”
cylinders rounded at the ends, by left dragging in open space.   Because of
this, regular, “button based” viewport navigation needs to be
accompanied by holding down the “Alt” key.

2D-Paint:   This tool paints voxel thickness on two axes which you specify
by right-clicking anywhere in space or on the surface of an object.  Notice
first that, as you rotate the view and move the brush, it’s moving along
the two axes. When you change your view, new strokes will always face
the camera.  Pick any Brush Alpha you like and just paint!  It also has an
important option on the top tool bar: “Double sided”. With this checked
you can paint double-sided strokes.

Plane:   This tool, new in version 3.2,
acts just like a carpenter’s wood
plane does. It will scrape the volume
away, from the set position as well as
the normal of the brush cursor.  You
set the brush cursor’s position and normal by clicking and holding the RMB
and then dragging along the surface of a voxel object.  There are five modes
by which you decide the position of the brush:

Pick point & forward direction:   This will place the cursor at the last
 location you used the RMB, facing toward the camera.

Pick point only:   This will place the cursor at the last location you
 used  the RMB only. Its direction is based on the settings in the
 parameters tab.

Pick point & direction:   This will place the cursor at the last location
 you used the RMB, and its direction will be based on the average
 normals of the voxels that your brush covers.
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Pick point & direction (local):   This will place the cursor at the last
 location you used the RMB, and its direction will be based on the
 single normal of the voxel your brush is centered on.

Navigate:   Lets you navigate the viewport. This can also be done
 while holding the ALT key.

Now we’ll continue with the other tools:

Scrape:   This tool is not affected by pens, just the Size of
the brush and the Intensity. It’s very similar to the Flatten
tool: it flattens the surface beneath the brush.

Pinch:   This is great for making very nice
tight edges, cavities and peaks.

Smudge:   This tool drags the surface
topology along with the brush. It’s great for producing
wrinkles on a character or a piece of clothing.

12.2 Adjustment Tools

Measure:   By clicking and dragging with the “LMB” you can
measure from the beginning to the end of your stroke allowing
you to more accurately sculpt to scale.

Pick:   Sometimes when you have more then one object in the
VoxTree, it can become a tad cumbersome to know which layer
has what object. With the Pick tool you can visually select the
object (and therefore the VoxTree layer) simply by clicking on
the one you wish to work on.

Pose:   This tool is great for quickly changing the rotation, scale
and translation of a selection. You can determine the selection in several
ways. You can use a line, ring, sphere -- and you can even paint on it with a

pen or an object.  Check the
Airbrush mode when using
Select with pen to increase the selection area smoothly. After a selection is
made, a special posing gizmo will appear.

The Pose tool has three states:   Rotate, Scale and Translate. You can
switch modes by clicking on the long red rectangular bar at the base of
the gizmo.  In each state the gizmo has set of parameters in the Params
window. Finally, as with all tools in 3D-Coat, the pose tool respects
symmetry, as well as all selection modes, like drag rectangle, lasso, etc.
Now, the Pose tool works on all visible objects (through all volumes).

Let’s now take a look at some of the pose tool
parameters:

Line:   This mode lets you draw a line-based gradient for use with the
 pose tool gizmo. It starts with your initial LMB click and ends with the
 release of the LMB.

Ring:   This selects a ring-based gradient. It starts with your initial LMB
 click and ends with the release of the LMB.

Sphere:   This selects a spherical gradient. It starts with your initial
 LMB click and ends with the release of the LMB.

Select with pen:   Selecting with pen mode lets you directly brush on
 your selection. The pen size directly affects the selection area.
 Furthermore, you can also smooth your selected area by holding
 “Shift + LMB”. This is a great way to select things quickly if you just
 need tiny little details selected. This mode
 also has a special option,

Airbrush mode:   By using airbrush mode
 you can also smoothly  selected areas
 instead of having a hard edged selection.
 It makes for tidy deformations around the edges of your selection.

Note:   “Select with pen” mode is very useful.  With the Pose tool, you can
use almost any of the selection methods in the Pen mode bar, like drag
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rectangle, lasso, etc. You can also subtract your selection by using the tool
normal while holding the CTRL key.

Object:   If you have multiple objects in your VoxTree,
this mode can  come in very
handy. Simply click on the
object you want to deform
 using the Pose tool and it
will place the entire  volume
as your  selection.

Use free form:  A new
feature has been added to
the Pose Tool which allows

for using a lattice to deform the selected Pose area.
Select from several lattice shapes to transform the Pose selection.

“Fit” and “Directional fit” give you the most control over the Pose area.

Move:   This tool is one of the most powerful and
versatile tools in the voxel arsenal.  Not only can it

“adjust” any shape, large or small, but it also can act as
an “Extrusion/Intrusion” tool.

Drag with the “LMB” to move the surface within the
area of the cursor, relative to the screen view. Hold
down the “Ctrl” key to move the surface along the
normal. The “Move” tool also interacts with Brush
Alphas - providing a wide array of effects.

Hide:   This tool has been improved greatly. You can
now hide on a per voxel basis. This lets you to paint the
areas you wish to hide, while it also respects other
selection methods, like drag rectangle, drawn
contours, etc. This new method of hiding makes it
much easier to create many hard edged surfaces for
objects. The tool also has a few other functions, which
you will find in the Voxel menu. They are listed as
follows:

Unhide all:   Unhides any hidden voxels.

Invert hidden:   Inverts hidden
voxels.

Delete hidden part:   Deletes
any voxels you have hidden.

Separate hidden part:   Creates a new Layer in the vox
tree and places the previously hidden voxels into the
newly created Layer.

Continuing with the other tools, they are:

Cell Hide:   This hides “cells” of voxels based on your brush size. Unlike the
other Hide tool, it does not allow sculpting or separating hidden parts to
create seams and other objects.

Copy:   To use this you must have two Layers in the Vox Tree It is preferable
if one of the Layers is empty, but it doesn’t need to be. In your other Layer
there must be a portion of a volume object you wish to copy: with this Layer
visible and your empty Layer active, you can brush along the surface of the
background object. This will copy the brushed areas to the previously empty
Layer. It is a really quick way to create objects based on a character’s surface
topology, like body armor, clothing, etc.

Transform:   This tool lets you rotate, scale and transform your currently
selected Layer. By grabbing one of the gizmo handles you can constrain
to whatever axis you clicked on. You can also perform a screen-based
rotation using the large outer circle. The options for this tool are:

Move only gizmo:   Lets you make adjustments exclusively to the
 gizmo. This helps when you need to place the gizmo in another
 location.

Leave rotated axis:   This is great for when you need to rotate an
 object multiple times while retaining its previous rotations.
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Position & Axes (1,2 & 3):
These parameters let you manually
key in   the position and rotational
coordinates.

Scale (X, Y & Z):   These  parameters allow you the  manually key
in scalar  modulations.

Reset axis/space: These two functions let you reset an
object’s axis or  local space.

Instancer: A memory saving method of
making duplicates of your voxel objects.
Instances consume far less memory than
duplicates.    You can  “Clone” an instance
(Right Click menu) and “Merge” new
objects as instances.  Negative volumes can also be
instances.

Warp:  You’ll find this tool is quite versatile! It lets you twist and bend the
currently selected object Layer in the Vox Tree.

Note:   Each function of the Warp Types will alter any of the other type’s
end functions.  Experimentation is strongly encouraged.

The following descriptions are based on the use of a default sphere, so
let’s take a look:

WarpType:   Drop-down list with two methods:
Bend and Twist. Bend will bend or wrap the current
Layer around the base of the gizmo. Twist will
rotate the current Layer around its pole. The
following functions are for the Bend type:
Segments count. Increases the number of
segments.

Start/Final angle:   Adjusts the beginning and end of the wrap.

Forward Step:   Create a “spiral staircase” look: it will literally spiral the
object upward.

Overlap:   This tapers each segment where they meet. The effect will vary
depending on the object.
The following functions are for the Twist type:

Segments count:   Increases the amount of segments.

Twist angle:   Twists the current object around the gizmo.

Overlap:   Tapers each segment where they meet each other,
simultaneously increasing/decreasing the space between each spiral.

Axial symmetry:   This tool lets you clone the active Layer from the Vox

Tree with axial symmetry:   You can set
the number of copies in the

Params tab:   The gizmo works just like
all the other gizmos. Move the translate
handler (octahedron-like) to get an idea
of similar things you can do with it. You are strongly encouraged to
explore this tool’s possibilities.

Bas relief:   This looks at the existing volume of an object, and extrudes to
create new volume based on the position of the
gizmo. The area at the base (sphere) of the gizmo from the tip is the area
that will be affected. It is great for creating coins and jewelry.

12.3 Object Tools

Logo:   The logo tool lets you import any black and white
picture and convert it to voxels. You can convert images
that are in the .BMP, .TGA, .jpeg and .PNG formats. Click
on the Logo tool and select an image. When imported,
voxels will be created on the basis of grayscale image. It
will default to the merge tool, so you can use the
standard merge gizmo here.
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Cut&Clone:   This tool will let you cut and clone the volume of a voxel
object based on the type of brush parameters. It defaults to the drag
rectangle pen mode and will copy the whole volume of the object
underneath. You can also adjust your border parameters with three
different types: Round, Plane and Sharp.

Clone: Clones the selection without
cutting.

Split:   This tool is very similar to the Cut&Clone tool. It has the exact same
border settings. The difference is that it tears a chunk of the object that
you are operating on and creates its own object Layer in the VoxTree.

Merge:   This tool lets you import polygonal meshes to convert into
voxels. Let us first go over some of the basic functions of this tool:

Select mesh:   Selects a mesh stored on your hard drive.

Pick from retopo:   If you have something retopologized in the Retopo
tab, then you can use the mesh to merge to voxels.

On pen:   Turns any merged mesh into a
“Merge on the Fly” tool, which allows you to
merge any object at the cursor position
(respecting the base object’s normals and
intrusion into or extrusion above the base
object).  Adjust the merged object’s size by
Right button - dragging left or right, and adjust

its intrusion or extrusion by Right button dragging up or down.

Subdivide:   Subdivides your un-merged mesh, giving it more initial
resolution before merging.

Transform:   Allows you to position any merged object with the aid of a
“Transform widget”.  Shift (X, Y & Z). Shifts the un-merged mesh along the
selected axis inside a bounding box in local space.

Presets:   This tool has a number of presets, you are encouraged to
explore them.

Some of the more advanced
functions of this tool are as follows:

Merge separate volumes:   Merges each sub-object to its own unique
Layer in the VoxTree.

Respect negative volumes:   If an un-merged object has “_negative”
listed in its name - (indicating a “subtractive” sub-object inside the file),
this function will subtract this volume when merging it with other sub-
objects. You should know in advance when you are going to use this
feature, as a “negative” or subtractive boolean object.  This function is
great for creating greebles and nurnies.

Let’s take a more detailed look at this feature.
(Thanks to our users Tinker and Daniel
Yarmak for the descriptions).

“Greebles” or “nurnies” can be created in any
3D modeling application, usually with a series
of arbitrary extrusions. To make your models
look more interesting, you would probably
want to create your own unique models for
this purpose.

Details with angled surfaces look better than surfaces which are all-
parallel.  For easier placement of details on a model, create a contour for
the detail -- an object with the
name “_negative” which
subtracts automatically from the
model and leaves a slot for the
detail.  It’s important to turn on

“Respect negative volume” in the Merge Params Panel to permit
contour exclusion.  Because the “negative volume” width is larger
than the width of the detail, we get an interesting effect. There is
automatically generated a joint
between the body and the object.
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Load the greebles using the “Merge” tool. Use the “On pen” mode and the
“9” and “0” keys to rotate the brush.

Sketch:   This new tool is a very important addition the the
toolset. It lets you create a volume object with 2 or 3 images -- if
you use 3 images, the voxel object will be more detailed. Please
try this new tool out, it is great for creating
basic shapes for a more detailed objects

very quickly. This tool has a few operations, all of
which are self-explanatory -- please explore the options for this tool.

Curves:   The “Curves” tool is easily one
of the most powerful tools in the voxel
arsenal, as it lets you place spline points
directly into your scene with the LMB.To
edit an existing point, simply click with
the LMB. To ESCape from editing a point, hit your ESC key. This tool also uses
a gizmo for transformations. The arrows will translate, the boxes will scale
or stretch, the inner white ring will translate on all axes. When using the
function Apply to whole curve there will be an outer white ring which allows

for viewport based rotations.   In addition to the standard
curve tools described above, there are now 4 modes:

Extrude:  Lets you extrude new hierarchies from the
existing point of a curve. Simply click and hold the LMB,
then drag in the direction you want to create the
extrusion. Holding SHIFT will default to the new Rotate

mode. It can also be activated with the “Q” key.

Move:   Lets you move points of a curve individually.
Adding the SHIFT key will move its child or parent
hierarchy, depending on the direction of the
manipulator arrow. It can also be activated with the

“W” key.

Rotate:   Lets you rotate the child or parent hierarchy
of a point with viewport based rotations. It can also
be activated with the “R” key.

Scale:   Lets you scale the child or parent hierarchy of a
point. It can also be activated with the “E” key.

NOTE:   You need to click the LMB to edit a point, esc to
stop editing a point. When using one of the four new
edit modes, you do not need to have a point selected.
Simply hold SHIFT (or turn on Invert SHIFT action) and
you’ll see green cones -- they let you edit the point and its hierarchy.
Finally, the affected direction of the hierarchy is the larger side of the
green cone.

These tools allow for quite a number of things, including pipes, chains,
basic character or creature shapes and bodies, and so on.  Here are some
of the parameters of this tool:

Fill Inside:  Fills the entire space between all points to create a solid
volume object throughout the entire space.

Run brush along curve:   Lets you perfectly indent or protrude areas
along the spline. It has a number of options which are all self-explanatory

-- please explore these settings.

Conform:   Forces the points of your curve to be constrained to the
surface of a volume object you drag across.

Jagged line:   By default the curves tool will create a smooth TCB-spline.
But with this option you can create a linear spline, essentially creating

“pointy” intersections.

Snap to symm plane:   Forces newly created points to be created on the
symmetry plane when you click on or near the plane.

Invert shift action:   This exclusively effects the four new curve modes. By
default in any of these modes you must hold SHIFT to perform their
alternate functions. This option will invert this setting, so that by default
you use the alternate functions, and the normal default methods require
you to hold the SHIFT key.
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Extrude same radius:   In the Extrude mode, this option creates a new
point with the same size as the point that you extruded from. By default a
newly created point is the size of your pen cursor.

New curve:   Adds another curve to your scene, in addition to your
existing curve(s).

Tube:   Resets the curve back to its default state.
Reset scale/angles. These two tools will reset any scaling or rotations you
have applied to the selected curve.

Hardness:   To use this you must have a point on a curve selected, then,
by pressing this button, the selected point will become sharp and pointed.
Closed. Closes the spline curve between the first and last points on the
spline. You can of course still add or remove points while using this
function.

Del curve/point:   These two functions allow you to delete curves and
points on a curve. You can also hover over a point on a curve and hit the
DELETE key.

Clear all:   Clears all curves from the scene.

Save/Load:   You can save and load entire sets of curves for use at a later
time, or for distribution to other users.

Profile:   This drop-down list contains a number of profiles, each
will change the overall shape of the spline curve.

Apply to whole curve:   With this any rotations, scaling or trans-
lation will apply to the whole curve centered from your current
selected point on the spline. The gizmo for the point will change,
adding a new large, white circle around the rest of the gizmo.
This new circle will allow for viewport based rotations.

Spline presets:   There are other, and
hopefully self-explanatory, settings for this tool.
But one thing you should definitely explore are the
spline presets. These let you perform many unique

voxel sculpting techniques and styles. You can also add your own by
using external files in the .OBJ or .LWO formats.

Snake:   Clicking and dragging with the LMB creates a snake-like shape in
your viewport. Its position is based on your first click and your viewport
perspective. As with the curves tool, you can reset it with the Tube button.
You can select a number of profiles and of course also use spline presets.
One unique parameter for this tool is the Smoothing speed. The snake will
smooth along its entire length, causing it to move. The higher the value, the
more smoothing. (Min/max values: 1-5)

Spikes:   Functions exactly like the snake tool, except that it tapers on the
end point, causing a spike-like appearance.

Muscles:   Lets you easily sculpt muscle- and
tendon-looking shapes. You can achieve many
different effects by, for instance, sculpting with this
tool outside of a volume to create objects that look
like wings.
There are a number of settings in this tool:

Smoothing Speed:  Lets you adjust the rate at which your stroke is
smoothed.

Conform:   Forces your stroke to adhere to the surface of
the object, instead of passing in front of the base object,
or right through it.

Muscle types:   Select between two different
types: Muscle and Tendon.

Toothpaste:  This tool shares all of the
options with the Muscles tool except the

muscle types. Its function is similar to its name: it is just like applying
toothpaste to a surface.  A big advantage is that it respects Pen alphas, so
you can use it to create some rather unique rake brushes.
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Primitives:  This tool has undergone a big change in version 3.2. While
retaining the oldrer primitives (Sphere, Cube, Ellipse, Cylinder, Cone,
Capsule, Tube, N-Gon and the Gear), there are now Free Form Primitives
(ffPrimitives)! These robust and powerful primitives let you create very
complex shapes with just a few easy tweaks of the vertices, edges or faces
of the lattice cage. There are a number of preset ffPrimitives, and you can
also create your own using .OBJ files -- see more on that below. A few of
the parameters for the new ffPrimitives are as follows:

Transform as whole:  Gives you the ability to translate, rotate and scale
using the default transform tool.

Local Symmetry:   Enables local symmetry of the ffPrimitive, which gives
you more creative freedom and control.

Misc. ResetPrim:  Lets you reset any changes you’ve made to the object.

EditPoints:   Allows numerical values for each visible point of the lattice
cage. Inner/Outer Radius & Thickness are only applied to some of the
ffPrimitives, such as ffDisc and ffTube, they allow for the radius of the in-
ner section or outer section of the tube and the thickness of some of the
primitives with keyable values. The drop down list also has a few more op-
tions, usually different .OBJ files with different cages for similar shapes,
such as ffDisc. When holding “Ctrl” you can constrain the movement of
your selection along its normal.

Text:   Lets you place text along a spline curve, and
create text in voxel form. Its parameters are identical
to that of the Curves tool, so you should already be
familiar with it after reading that section above. It

has a few unique features: You can select a font for your text, you can of
course type in the text you would like to make volumetric, and you can
adjust the thickness of this volumetric text.

Cloth:   This tool is a cloth simulator which you can use to drape a polygon
mesh over another object. There is
a default Cloth with which you can
test, but you are not limited to this
as you can also import an external

polygonal mesh. The parameters for this tool are:

Select mesh:   Prompts you with a file-open dialog which lets you
 select a file (.OBJ, .LWO, .FBX, .STL, .PLY, and .3b) on disk to use as
 the  object to be draped.

Subdivide:   Subdivides the object you have imported. It can be used
 before or after you run the simulation.

Start/Reset:   These two buttons
starts and resets the simulation.

Pick from retopo: If you have r
 etopologized something and it is
 in the  Retopo tab, then you can
 use this button to select that mesh
 as the  object to drape.

To retopo:   Sends the recently draped mesh to the Retopo tab for
 further retopologization.

Other:   Sets a number of other parameters, such as the Gravity, and
 the Friction of the draped object on the object you are draping over,
 as well as the Cloth thickness. For thickness,

the higher the value, the thicker the cloth.

12.4  Surface Mode & Tools

In version 3.2 of 3D-Coat the surface tools
have undergone some major changes, and, as of version 3.5 these tools
have inherited all the universal improvements of the Brush Engine, with
fantastic enhancements to the existing and new tools.  You’ll notice speed
improvements, throughout.

To change to Surface mode, you must click on the Cube icon in the VoxTree
for the Layer you would like to edit in this mode. You will then see a Wavy
line icon which represents surface mode. Surface mode is much faster for
sculpting than the regular volume mode.
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Surface mode was designed to give users the ultimate speed boost for
sculpting, by temporarily converting a voxel sculpture to surface
polygons.  You can switch back and forth between standard Voxel mode
and Surface mode as often as you like.  Though the tools are similar to
their voxel equivalents, they are generally faster to use on dense models,
as well as providing effects that can’t be reproduced, economically, in
standard Voxel mode. We’ve also included the Pose, Move and
Transform tools in this mode.
Here is a description of the tools, in detail:

Draw:   The Draw tool is great for quickly adding spontaneous detail. It is
similar to the the Airbrush tool, but it only operates on the surface of a
volumetric object.

Smooth:  Produces much more dramatic smoothing than can be
achieved with the standard Voxel equivalent.

Pinch:   Surface Pinch is identical to the Voxel Pinch tool, but it is faster
and only operates on the surface of a volumetric object.

Shift:   This tool drags the surface topology along with the brush. It’s great
for producing wrinkles on a character or for making cloth.  It is identical
to the Vox Follow tool, but it only operates on the surface of a volumetric
object.

Flatten:   This tool has been improved in version 3.2, and now
allows for a more predictable behavior. It flattens the area
underneath your brush, based on brush size and intensity.

Chisel:  Similar to the Flatten tool, but it’s effect is less extreme
and provides some irregularity along the stroke.

Clay:  Surface Clay lets you quickly and fluidly apply mass to your voxel
sculpture. The difference between this tool and the Carve brush is that it
will also simultaneously smooth the surface after you’ve brushed it, giving
it an authentic clay look.

Fill:   Surface Fill is a great way to fill in small voids and gaps in your
objects. It is especially effective at very high settings.

Expand:  Expands all vertices outward, uniformly, to a given radius.

At the top left of the interface are the Extrude Direction Settings. This
allows for user definable extrusions. The extrusion methods are as follows:

Average normal, View direction, Along axis (X, Y or Z), Vertex
 normal & Initial vertex normal.

These settings are unique to the following three tools:

Extrude:   Extrudes along the surface under your brush,
based on your pen Size, Depth and Extrude direction
settings.

Gum:   This tool is great for making nice details on a mesh. It is unique for
the surface tool set. It’s the fastest way to make skin, pores and wrinkles.
The higher the resolution of your object, the better the details look. This
tool is commonly used to sculpt minute details onto an object. It is
affected by the Extrude direction settings.

Absolute:   Extrudes the surface based on your Brush Size, Depth and
Extrude direction settings, while also maintaining the underlying surface
details and topology.

Freeze:   A very useful masking tool, which allows
you to define areas to be avoided by sculpting tools,
or inverted to be the focus area for sculpting.  The
common shortcuts are “Ctrl+Shift+ I” (inverts your
selection) and “Ctrl + D” (which deselects it).

Rapid & Rapid2:   This tool’s name is very descriptive, as
it’s one of the fastest tools in 3D-Coat to sculpt general
shapes. It is almost the opposite of the Gum tool in this
regard, as it doesn’t respect Brush alphas but only brush
Size and Intensity. Another great thing about this tool is
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that if you have two voxel objects in the viewport that are
separated from  each other in space, it will try its best to form
a bridge between them (welding them together as one
object).

Scratches & Scratches2:   Provides a similar effect which clay
sculptors use to “rough out” surface features quickly.

Mud & Mud 2: An interesting surface texture effect, providing rough
edges.

12.5 Surface Adjustment Tools
A small subset of those same tools that appear in “Standard Voxel
mode, offering faster response due to the nature of polygonal
surface meshes, which are at the heart of the Surface mode.

12.6 Surface Commands

There are only a few Commands in the sidebar, but they are all very
important. Let’s take a look:
.
Resample:   This command quadruples the number of voxels in the
current object Layer. This lets a Layer have much more detail. You can
view the resolution of a Layer in the VoxTree directly before the Layer’s
name. If it has only the name, that means the Layer’s resolution has not
been increased.

Clear:  This command clears the current Layer in the VoxTree of all voxels.
It is useful when you wish to keep the current Layer’s name and resolution

-- but not the voxels objects in it.

Smooth all:   This command uniformly smoothes all of the voxels of the
currently selected object Layer in the VoxTree.

12.7 The VoxTree

You have the ability to drag and drop Layers for several different purposes,
such as moving a Layer to the trash, re-parenting by dragging to a Layer’s
+ sign, or simply reordering the Layers to organize them.
These functions involve the primary Vox Tree icons.  Let’s
take a look, in detail:

Collapse child Layers:   The minus next to any Layer lets
you collapse any child Layers it may have.

Root:   This is the base file or scene. You cannot edit this.
Visibility:   By clicking the Eyeball icon you can toggle the visibility of a
Layer on or off.

Cube/Wavy line:   These icons toggle between volume mode and surface
mode. Volume mode is represented by the 3D cube icon, surface mode by
the Wavy line icon.

Cache/Uncache:   Represented by two
icons, which toggle when clicked. One
looks like a hard disk drive with an arrow
pointing downward to it, the other and

upward arrow which curves to the right. These icons will toggle proxy
mode and will apply any changes made from the low resolution proxy to
the high resolution sculpture.

Add Layer:   The plus sign next to any Layer will add a new child Layer. If
you add a Layer to the root, it will have no parent.

Layer name:   Each Layer is represented by a horizontal bar. By double-
clicking the bar you can change the Layer’s name.

Layer resolution:   If you have changed the resolution of a Layer, there
will appear a number representing this change, like [2x], [4x], etc.
Now let us look at the icons on the bottom of the VoxTree:

Blank sheet:   Creates a new child.

Trash can:   Deletes your currently selected Layer.
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2 Blank sheets:   Duplicates your currently selected Layer.

Ball:   Edits the currently selected Layer’s shader properties.

2 Blank sheets w/grid:   Duplicates the currently selected Layer’s
resolution and transformation settings. Nothing else will be duplicated.
This is useful when you need a new Layer with the same settings but not
the same voxels.

Double-sided arrows:   This icon is for the Symmetry copy tool. If you
have sculpted on one side of a volume object you can use this fuction to
copy all your work to the other side of the object. It works on any axis, as
long as you have symmetry turned on along the preferred axis.

Grid:   Increases resolution.

Sheet w/ down-arrow:   This icon duplicates your
currently selected Layer and decreases its resolution
by a factor of 2. This is useful if you have an object
Layer with too high resolution and you need to reduce
it for easier editing. Be aware that you will lose details!

Sheet with “X”:    Clears the selected object Layer in
the VoxTree of all voxels.  It is the same function as the
Clear tool on the left side tool bar, as discussed in the
Commands section.

Individual voxel layers now can be exported as
single .3b file:

12.8 VoxTree Right-click Menu

There are many functions in the right-click menu inside
of the VoxTree. Some of them are unique to this menu,
most however, are not. They are as follows:

Delete:   Deletes the selected Layer.

Add sub object:   This is the same as clicking the “+” icon near the Layer’s
name. It adds a Layer that is a child of the current Layer.

Rename:   Type your own name for the Layer, instead of the default
“Volume XXX”.

Save volume to 3B:   Saves the voxel volume without its subtree to the
3D-Coat native file format.

Save volume with subtree to 3B:    Saves the voxel volume with its
subtree to the 3D-Coat native file format.

Merge 3B file:   Merges an external .3B file into the scene.

Edit shader settings:   Edit custom shader’s parameters, if it has them.

Import:

Merge points cloud:   Merge set of points as a sequence of a small
 spheres.

Export:

Export scene:  Exports the whole scene as a set of separate objects.

Export object:  Exports the current object.

Export pattern for merge:  Exports the current object to be used as
 a pattern for the Merge object tool.

Export curve profile:  Exports the current object as a profile for a
 curve.

Clone instance:   Clones and transforms an instance of an object.

Clone:    Clones and transforms a voxel object.

Clone with symmetry:   Clones with symmetry and transforms.
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Clone and degrade:   Clones and decreases density twice.

Clone space density:   Creates space with identical density and
transformation. It is important if you want to use the Copy tool without
loosing quality.

Decrease object 2X:  Increases the selected object Layer’s density twice.
Object will decrease twice.

Increase object 2X: Decreases the selected object Layer’s density twice.
Object will increase twice.

To global space:   Moves the object to 0 on all axes. This is great when
you need to move something directly into the center of world space to
allow for a more perfectly symmetrical object when symmetry is active.

Resample:    Duplicates the same command present in the Surface Tools.

Extract skin: Makes a hollow skin based on a solid voxel sculpture. There
are 2 versions of this function - “Make hull using voxels” and “Make hull
using surface”. The former is more accurate, but takes longer to perform
while the latter is faster and less accurate.

Fill voids: Makes any voxel object a contiguous solid, which is necessary
for creating proper topology - either automatically or manually.

Extrude: Extrudes all objects in the current layer outwardly by a specified
amount. Enter this amount in the Extrusion parameter Dialog.

Transform: Transforms a whole object using a special gizmo.

Apply axial symmetry: Applies axial symmetry of any kind to
the object.

Create edgeloops with AUTOPO: Attempts to create edge loops based
on the underlying surface topology, when using the AUTOPO tools.
Various auto-topology methods are mentioned below.

AUTOPO: Using a “quad dominant algorithm”, this routine creates surface

topology based on your specifications, and places the resulting polygon
mesh in the Retopo Room for further modification or refinement.

AUTOPO with Ptex: Runs the routine mentioned above and places the
resulting mesh in the Paint Room for painting using Ptex.

AUTOPO with MV Paint: Runs AUTOPO and places the result in the Paint
Room for painting with the “Micro-vertex” method.

AUTOPO for Per Pixel: Runs AUTOPO and places the result in the Paint
Room for painting with the “per-pixel” method.

There are a few things to note about the AUTOPO tools. It is a good idea to
enable symmetry planes to force symmetry during the process of
creating
automatic topology - (assuming you want a symmetrical object). If the
object is not fully symmetrical, the program will keep symmetry only
whenever possible. If you do not like the automatic result, you can always
go to the Retopo Room to manually adjust the mesh to suit your needs.
Also, when using this function, 3D-Coat will automatically create a new
sub-object in the Paint tab for each object layer in the VoxTree.

Combine with children: Combines all child layers of a parent layer, into a
single layer.

Flip: Flips the current layer on any axis (X, Y, or Z).

Merge Visible: This will merge all objects in the VoxTree that
are not hidden to the current layer - leaving all visible layers intact.

Merge subtree: Merges all sub-layers to the parent layer, deleting the
sub-
layers in the process.

Merge to: Merges a copy of the current layer to a specified layer.

Move to: Moves the current layer to another layer.

Subtract from: Subtracts an object in the current Layer from the object
in
another layer that you select. This is a very powerful function in 3D-Coat: it
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allows boolean subtractions of one object Layer from another.

Intersect with: Adds an object in the current layer from the object in
another layer tha tyou select. This is similar to “Subtract from”, but allows
boolean additions.

Change parent: Changes the current Layer to another Layer or to the
Root.

12.9 The Voxel Menu

Like most of the other major Tabs (or Rooms as they are also
called), there
is also an accompanying menu. We have already covered
most of these
options in previous sections. Any repeated functions are
here only for your convenience. Let’s take a look at them:

Define measurement units: Specify the measurement of
units (Metric or
Imperial standards) here in real world scale, and how many
voxels per this
unit scale.

Edit scene scale: Allows you to redefine the scale of the
entire voxel
scene. This corresponds to the setting you clicked after
merging an object
into the scene, and replied “Yes” to the opening dialog.

Res+: This command quadruples the number of voxels in
the cur-rent object Layer. This lets a Layer have much more detail. You can
view the
resolution of a Layer in the VoxTree directly before the Layer’s name. If it
has only the name, that means the Layer’s resolution has not been
increased.

Resample: Allows you to adjust the resolution of a voxel layer to an
arbitrary number.

Symm copy: If you have sculpted on one side of a volume object you

can use this icon to copy all of that to the other side of the object. It works
on any axis, so long as you have symmetry turned on along the preferred
axis.

CleanSurface:  Re-optimizes surface mesh structure.

CloseSurfHoles:  Heals any holes found in a surface.

CleanupMemory:  Optimizes mesh memory allocation.

Clear: This command clears the current Layer in the VoxTree of all voxels.
It is useful when you wish to keep the current Layer’s name and resolution
but not the voxels.

Smooth: This command uniformly smooths (or relaxes) all of the voxels
of the currently selected object Layer in the VoxTree.

Unhide all: Unhides any hidden voxels.

Invert hidden: Inverts any hidden voxels. Delete hidden part. Deletes
any hidden voxels. Separate hidden part. Creates a new Layer in the
VoxTree and places the previously hidden voxels into the newly created
Layer.

Delete Hidden:  Deletes the hidden part of the surface.

Separate hidden part:  Creates a new volume from the hidden surface.

Hide all but current:  Hides everything not selected.

Toggle proxy mode: Toggles on/off proxy mode.

Restore visible volumes: Will recover the high resolution voxel sculpt
previously cached, into voxel surface mode. (This is a redundant feature.
Using Toggle proxy mode or the icon for said feature, will achieve the
same result)

Downgrade visible volumes: Caches the current high resolution voxel
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sculpt. (This is a redundant feature. Using Toggle proxy mode or the icon
for said feature, will achieve the same result)

Clear all caches: Clears any cached proxy meshes. This cannot be
undone,
so use only when needed.
Proxy visualisation: Selects the resolution of the proxy mesh and how
far downgraded the mesh is (You can downgrade from 2x, 4x and 8x).

Multicore: Toggles on/off voxel multi-threaded functionality.

Cast shadows: Enables shadow casting based on the global light
inside the viewport. It is purely aesthetic.

Incremental render: Renders only the parts of the object that
have changed since your previous render, thus giving a large boost in
performance. This option is off when shadows are on, as shadows are
dynamic and change the appearance of the rendered object.

SkipRendering:

Use CUDA:  Employ CUDA acceleration.

CUDA smooth boost:  Makes use of special CUDA smoothing.

Highlight: Toggles highlighting, if it is turned on for your selected
VoxTree object will be highlighted a different color. When off, there will be
no visible change. This efffect is dependent on the shader.

Accurate smoothing: Provides more accurate smoothing, at the expense
of performance.

Grow on pen motion:

13.0 Shaders

The shaders tab is pretty straightforward. You
simply RMB click
to select a new shader to apply. If you RMB
click a shader, you’ll see a few
options:

Delete Shader: Deletes the shader you clicked.

Construct new shader: Lets
you create a new shader. The
new
shader will be based on the shader you clicked.

Select default shader: Applies the shader you clicked as the default
shader. Whenever a new volume object is created, it will have this new
default shader applied.

Edit current object’s shader settings. This is pretty self-
explanatory.

Please check out each shader’s specific settings.

Refresh (all) preview(s). These two options refreshes the shader tab. It
is helpful if you have trouble with a newly created shader not
showing up as a selection.

13.1 Multi-Resolution & Caching
Using this method for sculpting speeds voxel sculpting up,
considerably, and provides much less hindrance when you’re in a
working mindset, allowing for minimal interruption. Essentially, you
cache your high resolution voxel sculpt to disk, then
proceed to sculpt on the low resolution proxy that 3D-Coat
automatically generates for you. Any changes made to the low
resolution object will be propagated upward to the high resolution
sculpture.
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This method is quite similar to what you can achieve now
with voxel surface mode, however, using this method you can choose
the resolution of the proxy mesh. In this section is placed all relevant
information regarding Multi-resolution and caching. Some of this
information may be redundant, but is all compiled in this section for
your convenience.

Apply to visible:  Only apply the selected shader to visible objects.

Apply to subtree:  Applies the selected shader also to subtree objects.

Toggle proxy mode: Toggles on/off proxy mode.

Restore visible volumes: Will recover the high
resolution voxel sculpt previously cached, into voxel
surface mode. (This is a redundant feature. Using
Toggle proxy mode or the icon for said feature, will
achieve the same result)

Downgrade visible volumes: Caches the current high
resolution voxel sculpt. (This is a redundant feature.
Using Toggle proxy mode or the icon for said feature,
will achieve the same result).

Clear all caches: Clears any cached proxy meshes. This
cannot be undone, so use only when needed.

Proxy visualisation: Selects the resolution of the proxy
mesh and how far downgraded the mesh is (You can
downgrade from 2x, 4x and 8x).

Multicore: Toggles on/off voxel multi-threaded
functionality. Cache/

Uncache. Represented by two icons, which toggle when clicked. One
looks like a hard disk drive with an arrow pointing downward to it, the other
and upward arrow which curves to the right. These icons will toggle
proxy mode and will apply any changes made from the low resolution
proxy to the high resolution sculpture.

14.0 The Render Room

In this section we shall discuss all that relates to the Render tab in
3D-Coat. First, one important point: do not hit esc to cancel a render
if you still wish to use the image! You must wait until it is complete if
you wish to have a final, useable image. Cancelling the render
will not do this. The render engine must be allowed to continue
its work until the render is complete!

14.1 Render Panel Functions
Render: Initiates the render of your frame or
frame sequence.

View size: Lets you choose between rendering
the Whole screen or a Custom size. If you choose a
custom size you can then key in the X and Y values of the area you wish to
render.

Render size: Lets you select a size for the rendered image. It is only
active if you are using a custom size from the
View size drop-down list. It will always be in
multiples of the size you choose as the custom
size.

Lightness. If you increase the value of
the AO percentage you will probably need to also increase the
Lightness of your scene, or it be be too dark.

AO percentage. The ambient occlusion changes your lighting type.
A value of 0 gives you direct lightening, a value of 100 gives you
completely “overcast” lighting.

Light scattering. Adjusts the amount of light that will be scattered.
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Higher values will give you softer shadows and softer specularity on
shiny objects.

DOF degree. Depth of field focus. Produces a “lens focus effect” on
your image. Set the distance from the DOF plane where objects
remain in focus.

DOF plane position. Moves a red plane forward or backward to set
the center of the depth of focus. Use the slider above to set the
distance from the plane (in front and back) where objects should
remain in focus.

Show DOF plane. Shows a focus plane where the details will look
mostsharp during DOF rendering.

Store alpha channel. Renders also an alpha channel. To use
this option you must choose .TGA as the output file format. If you
are rendering an image sequence, the .TGA format will be chosen
automatically.

Anti-aliasing. Smoothes the edges of your rendered objects. Keep
it checked!

32-bit rendering. Use this option
only if have good enough graphic

card (GeForce 8, 9
or better). 32-bit
rendering provides

a higher quality render by allowing for an “infinite” number of rays.

Render result. Choose the image format and a folder to store
your rendered scene. Only apples if
Render frame sequence is unchecked.

Render frame sequence. Renders a frame
sequence rotating around the object or along
the camera path. If checked, an additional
parameter will appear:

Folder to store images. The name of a folder
that will be created to store rendered frames.
The folder is placed into Install dir/

RenderedImages/...

Please note that you cannot change this default path.

Save lossless images. Saves images in lossless formats, namely .TGA
and .bmp.

Don’t overwrite files. Prevents overwriting of files during a sequence
rendering.

Closed spline. Use if you have several camera shortcuts set up in
the scene.   In this case the Camera flight trajectory will be closed.

Rays per frame. Sets the maximal number of rays per frame
during rendering. The rendering time is proportional to this value.

Frames to render. Sets the number of frames to render.

Counter clockwise. Sets trajectory direction: clockwise or counter-

clockwise.
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Render sub sequence. Check if you want to render or re-render only
some frames of a sequence. You must set the first and the last frame to
render.  As mentioned in the beginning of this section: do not hit esc to
cancel a render if you still wish to use the image! You must wait until it is
complete if you wish to have a final, useable image. Canceling the render
will not do this.

15.0 3D-Coat Main Menu Panel

15.1 File:
New. Clears the current scene and creates a new one.

Open. Opens 3D-Coat’s native .3B format.

Open Recent. Displays recently open files.

Install Extension. You can create whole packs of
resources, from brushes, masks, materials and more, into
one single file.  The format is 3DCPACK. This allows for easy distribution of
said files, to other users! Tocreate a pack, use the Save Extension. It will
run a wizard to help you create such packs, and also prompt you for a .txt
file which contains any licensing you wish users to adhere to for your
3DCPack. Using the Install Extension prompts you to select a .3DCPACK
file to install.

Create Extension:

Browse: Search all available 3DC resource folders.

Save. Saves file.

Save As. Saves files in .3B format. You can rename the file or place it into
another directory.

Save Incrementally. Saves the file with an iterational file name, for
example, “file_001.3B”, “file_002.3B”.

Merge Object. Merges additional objects into the scene. Caution: Don’t

merge objects with very different scales!

15.2  Import:

Model for per pixel painting. Imports a mesh to
paint directly over pixels in a UV-set. This approach
will give better quality of painting over a texture
because the painting will be performed directly over
pixels in a UV-set. Use this for normal maps and
texture maps.

Model for microvertex painting. Imports a mesh for use with the
microvertex sculpting and texturing tools. Use this for displacement maps
and vector maps.

Model for Ptex painting. Imports a mesh for use with the Ptex
texture painting and UV tools. Use this if you wish to paint extremely
high resolution details and not worry about UV mapping. Ptex is a new
method for texture painting and UV mapping. For more information
on Ptex, see the Ptex section of this manual.

Import for AUTOPO:  Imports a mesh for instant access to automatic
topology parameters.

Import retopo mesh:  Imports a mesh directly into Retopo Room.

Reference Mesh. Imports the mesh to use as a reference for the
retopology tool.

Big Mesh. Imports a large mesh (up to 16 million polygons). This function
requires two meshes; a low-poly reference mesh and a high-poly mesh.
Both should have the same non-overlapped UV-set. First import the low-
poly mesh into scene using the usual import

dialog, then load the high-poly mesh using this option.

Image Plane. Loads a flat square object and applies color and depth
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images for bump mapped tiled textures. Edit 2D images and add relief to
them. Using the Image Plane tool together with Textures and the Offset
tool you can loop the textures. Currently only square textures
are supported. This option is very useful to make tiled displacement
textures.

SL Object. Import sculpt map from Second life.

Import mesh for voxelizing:  Imports a mesh directly into the Voxel
Room.

Import raw voxel data:  Imports a specific voxel file format into the Voxel
Room.

15.3  Export:

Export Mode. Export the current object to .OBJ, .LWO, .STL and .PLY
formats. You will be prompted to select either a low-poly mesh, or a mid-
poly mesh with 30k to 80k polygons and the normal map. If you’re in the
Microvertex painting mode, the Export menu will have additional
options:

Export scene:  Exports all the objects in a scene.

Export object:  Exports a single object.

Export dense quads:  Exports a high quality quad skin of any voxel object.

Export projected quads:  Exports a quad mesh similar to Zbrush’s
Dynamesh.

Export pattern for Merge:

Export curve profile:  Export the current curve data produced with “E”
panel tools.

Export raw voxel object:  Exports a voxel object in specific voxel file
format.

Exit. Exits the program.

Edit:

Undo.

Redo.

Mesh and Texture Resolution. Changes the number of polygons in
the object and the size of the texture. You can change mesh
resolution multiple times (like with other 3D software), but you can
also do it in percentages, for example 50%.

Sync Layers with Ext. Editor. Lets you synchronize the current Layer
with an external editor. You can set the file path to the editor in the

By default it is Adobe Photoshop. The alpha channel will contain
the transparency mask. With this command the image editing
program will open automatically with your file. Then you can edit
it and jump back to 3D-Coat by pressing “CTRL+S”.

Edit All Layers in Ext. Editor. Edits all Layers in an external editor. You
can set the file path to the editor in the Preferences. By default it is
Adobe Photoshop. This image editor should be able to edit .PSD files.
The texture will be stored with Layers to the .PSD file, then the image
editor will start. You can edit the texture and even add new Layers.
When you save the file, 3D-Coat will automatically reload it.

Edit all specular layers:  Specific access to only edit info found on
specular layers.



59/120

Edit Projection in Ext. Editor. Edit the current projection in
Adobe Photoshop, or any image editor, using Layers. You can set the file
path to the editor in the Preferences. By default it is Adobe Photoshop.
This image editor should be able to edit .PSD files. The projection will be
stored with Layers to the .PSD file, then the image editor will start. You can
edit the projection. When you save the file, 3D-Coat will automatically
reload it.

Project through:  Allows use of specific tools through all visible layers.

Load hotkeys:  Loads your custom hotkeys from disk.

Save hotkeys:  Saves your custom hotkeys to disk.

Customize UI:  Allows you to hide or show any menu or interface item.

15.4  Preferences:

Show beta tools: Allows testing of any tools not yet in the main release.

Autosave. The slider “Autosave time” adjusts the time interval
for autosaving. The autosaved file has the name

“autosave.3B,” which is located in the folder “User Data”.

External 2D-editor. The application in this file path is used
to edit 2D-images. This editor must be able to edit .PSD files,
so usually it would beAdobe Photoshop (but it could also be
Corel Painter, for instance). This editor will be called by the
functions “Edit,” “Sync Layers with Ext. Editor, Edit All
Layers in Ext. Editor and Edit Projections in Ext. Editor”.

Near plane modulator. Tweaks the camera near plane to be able to
move it closer to the surface.

Show hints. Hides or shows hints. Hints are located at the bottom of
the viewport.

Axis. Shows or hides the axis.

Show “Focal shift” in the top panel (Show “Focal shift”slider in top
panel).

Show “Falloff” in top panel (Show “Falloff”slider in top panel).

Compact interface. Toggles between compact/full interface.

Show import thumbnails on start page.

Show interface thumbnails on start page.

Also you can specify:

Screen space grid size. 2D-grid size.

Grid subdivision. 2D-grid subdivision.

Background type. Vertical gradient/Background image/Panorama.

Background image.

Sky box image.

Top background color.

Bottom background color.

Screen grid color.
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Grid color. 3D-grid plane color.

Interface color.

Headers color.

Text and white icons color.

Edit area color.

Edit area border color.

Edit area highlight color.

Active tab color.

Passive tab color.

Tab background color.

Active tab font color.

Headers font color.

Buttons color.

Highlight color.Hint background.

Hints text color.

3D button style. Uses 3D style for buttons.

Gradient in menu. Uses gradient style for menu.

Environment sphere map. Chooses a sphere map used for Show
model with environment map.

Slightly lower shader quality. Select this option if you experience

performance problems.

Use multi-core optimization.

Use MRT. Uses multiple render targets to speed up real-time
normalmap updates.

Pen sensitivity. Adjusts Pen sensitivity if you are using a digital pen.

Camera zoom speed.

Camera rotation speed.

Freeze pattern scroll speed. Freeze pattern scroll speed. You can change

‘the freeze preview patterns in the freeze menu.

MOUSE WHEEL. Which parameter to change with MOUSE WHEEL.

CTRL+MOUSE WHEEL. Which parameter to change with CTRL+ MOUSE

WHEEL.

SHIFT+MOUSE WHEEL. Which parameter to change with SHIFT+MOUSE
WHEEL.

ALT+MOUSE WHEEL. Which parameter to change with
ALT+MOUSE WHEEL.
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Here is a list of suggested parameters for the last four options:

Normal maps export. Selects the standard for normal maps exporting:
3D-Max or Maya.

Padding. When you export textures you will be asked if you need a
border around the texture clusters (padding). This option lets you answer
the question automatically.

Padding width. Used when texture exporting.

3DConnexion options. 3D-Coat supports the 3D SpaceNavigator
from 3DConnexion. You can find all the options to control your 3D mouse
here.

15.5  View:

Relief only. Displays relief maps only in the viewport.

Flat shade. Displays a flat
shaded view in the viewport.

Specular only. Displays only your specular maps
in the viewport.

Show displaced mesh. Shows actual mesh displacement. The vertices
of

the mesh will be displaced along the normal in correspondence with
the

displacement map.

Wireframe. Shows the wireframe of the model.
Low-poly. Views and edits low-poly model with normal map.

Smooth Shade. Enables Smooth shade (hot key
“5”).

Low Smooth Shade. Enables Low Smooth
Shade (hot key “7”).

Environment Shade. This is the default. It displays
all the maps you have

applied in the viewport.

Grid. Turns on/off the 3D-grid plane in the 3D viewport.

Grid density. There are 4 levels of density
for the grid. Rare, Normal, Dense and
Custom. With custom, you can set the
number of major lines and the number of
minor lines between the major lines.

Axis. Shows/hides the axis.

Grid 2D mode. Turns on/off the 2D-grid of the screen. You can key
in values for rotation, pan and zoom for more accurately grid
placement.

Snap to Grid. Snaps to the 2D grid. This is
usually used in conjunction with the Curve
tools (draw with spline, putting text on
curve and putting picture along spline). With
Snap to grid on you can snap the points of
the curve to the 2D-grid and draw very exact
shapes.

Snap to low-poly vertices. Snaps your pen to low-poly vertices.
Helpful when you are retopologizing or texturing.

Orthographic Projection. Toggles perspective/orthogonal projection.
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Adjust subpatching. Improves the visual appearance of mesh
displacement using subpatches. Subpatching is a grid NxN on every face.
Use this option only if you are certain your video card is powerful enough.

15.6  Textures:

Import. Import color/diffuse in .TGA,
.BMP, .PNG, .JPG, .DDS, and .PTX
formats and layers color in

.PSD format. Impor ts pecular in,
.TGA, .BMP, .PNG, .JPG, .DDS and
.ptex formats and specular layers in
.PSD. Import normal maps in .TGA,
.BMP, .PNG, .JPG and .DDS formats.
Import displacement in .TIF, .TGA, .EXR,

.BMP, .PNG, .JPG, .DDS, and .PTX formats. Vector displacement in .TIF,

.EXR, .TGA, and .BMP. Lastly Depth layers in .EXR.

Export. Export color/diffuse in tga, .BMP, .PNG, .JPG, .DDS and
.ptex formats and layers color in .PSD.

Export specular in tga, .BMP, .PNG, .JPG, .DDS and .ptex and
specular layers in .PSD. Export normal maps (World &
Tangent space) in .TGA, .PNG .BMP and .DDS. Export
displacement for current layer or all layers in .TIF, .EXR .BMP and

.PTX. Depth layers in .PSD. Vector displacement in .EXR, .BMP, .TIF
and .TGA.

NOTE: When you choose Import/Export displacement a context
window will appear. In the drop-down list there are four items for map
type:

Use Original UV. This option is important for models with overlapped
 UV clusters, for example with mirrored UV’s. In this case you should
 load the model with the “Keep clusters”option on UV-coordinates will
 be changed in such a way that texture clusters will not overlap each
 other. Models and textures will be exported with the original UV-set if

 the option “Use Original UV” is checked, otherwise they will be
 exported with the new UV-set.

Save Specularity as Alpha in Normal Map. Saves the specular channel
to a normal map as an alpha-channel.

Save Displacement Map to Alpha.  Saves the displacement to the alpha
channel of the normal map.

Adjustments. There are many Layer adjustments commands, such
as: color to specular, invert color, invert specularity,
set height to zero, make transparent, remove specularity,
smooth current Layer, sharpen current Layer,
hue/saturation/lightness, CMYK, transform color space,
brightness/contrast, RGB. All of them can be viewed with real-
time preview and they can be applied not only to the current
Layer but also to all the Layers.

Import UV. Imports an object that contains a UV-set. The new UV-set
will replace old one.

Export UV. Exports an object without textures. This command could
be used in pair with Import UV. You can export a UV-set, adjust it
externally and then import it again.

Export SL Sculpt Map. Export a “Second Life”sculpt map.

Texture UV Editor. Don’t let this
wonderful feature slip by.  It’s like
having a mini-Photoshop available
right within 3D-Coat.  With the
built-in 2D texture editor, you can
paint in 2D and 3D windows
simultaneously. You can paint in
3D and the results will be shown
in the 2D window simultaneously
and vice versa.   From the drop
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down menu, you can choose to paint separately on “Color, Specular,
and Normal” channels, or your can paint on the “Shaded” version of
your UV unwrapped texture.  You must select a UV-set in the drop-
down list at the top left of the 2D Texture editor window to paint in it.

Offset tool. You should load only square images with this tool. It comes
in handy to create tiled textures with bump and specular. Once a square
object is loaded, you will be offered the “Offset tool” window where
offset values can be specified: U offset, V offset and texture shifting
horizontally and vertically in accordance.

15.7 UV Manager

If there are several objects in the
scene, separate objects can have
a separate UV. Use this command
to manage them.  You can group several materials into a single UV-set.

Texture Baking Tool. This lets you bake details to a normal or displacement
map. This can be used even when the surface topology doesn’t match
perfectly between your reference mesh and low-poly mesh. This tool is
quite detailed and has it’s own section below, please see that section for
further information.

Calc Occlusion. Allows calculating the
global illumination from many
spotlights that are distributed over
the half-sphere. The grey scale
results will be written to the current
Layer. So it is better to create a

new Layer and set the color operation “Modulate” or “Modulate2X”.
The Calc Occlusion tool is especially optimized for high polygons
(several millions), it is fast but it still need some
time with high polygon counts:

Light sources (distribution of lights).

1) over hemisphere

2) over sphere

3) over hemisphere + sphere

Lighting render target. You must choose a Layer where the
occlusion calculation is placed. You can choose to add a new
Layer automatically or overwrite the current Layer. In the first case,
do not forget to delete a new Layer for the light calculation. Also a
new color option “To time” is added for a new Layer. In the case
of rendering the former Layer, all of its color information will be
deleted.

Lights count. The more lights, the longer the calculation. The more
light sources, the better the quality of lighting but the longer its
calculation. The maximum value is 256, the minimum value is 16.

Post-smoothing steps. Sets the amount of post-smoothing steps after
occlusion calculation.

15.8  Symmetry

Symmetry in 3D-Coat is used when drawing,
sculpting or retopologizing objects. For quick
access, press the “S” key. In this menu you will
find a number of settings. You can toggle on/off

symmetry, turn on a specific axis for symmetrical work (X, Y or Z axes),
or simply toggle the visibility of the symmetry plane. By default, symmetry
is not activated. You can also change the
position of the symmetry plane by pressing
and holding the tab key.

15.9  Windows

Popups.  With Popups you can show any
popup  window in the viewport easily.
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There are many popup windows -- and all of them are useful.  Some
of the popups are already located in their tabs in the right side panel.

Sliders. View any of the available sliders for all tools that use one. The
rest of the options are self-explanatory. You can reset
the current Page or all pages to their defaults, save
your page or whole Workspace layout to a file, and also
load it when needed.

16.0 Help

Uninstall license. Clicking this will
uninstall the license on the current
machine you are using.

3D Coat Manual. Will open up this manual.

Upload screenshot. Great for bug reporting directly to Pilgway,
especially if you have trouble uploading images to the forums or other
locations to show others your screen. Using a yellow bounding box to
select the area to capture and upload.

Migration master. Allows you to copy pens, strips, etc. From one
installation of 3D-Coat to another.

Language. Change the interface language of 3D-Coat.  The current
languages translated to are: Chinese, English, French, German,
Japanese, Russian, Spanish and Traditional Chinese.

Community. Will load the URL of the 3D-Coat forums. If you need help
right away, this is the best way to get help quickly. The users are friendly
and always ready to help.

Check for Updates. Will check to see if any updates to 3D-Coat

are available.

About 3D-Coat. Lists the staff,
personal thanks and the story
behind 3D-Coat

17.0  Texture Baking Tool

This tool lets you bake details to a normal or displacement map, even if the
surface topology doesn’t match between the two meshes you wish to
bake -- the reference mesh and the low-poly mesh. Here are some detailed
steps to use this tool:

For a Displacement map.

Turn on.

Uses current low-poly mesh

Smoothes mesh

Preserves positions

Turn off.

Uses original positions For a Normal map.

Turn on.
Uses current low-poly mesh

Turn off.
Uses original positions

Smoothes mesh. You’ll need to have “Use current low-poly mesh
and “Smooth mesh” turned on, with “Use original positions”
turned off. To get a displacement map you should set the “Smooth
mesh” option, because displacement is calculated as the difference
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18.0   Customize Hot Keys & User Interface

3D-Coat is fully customizable, and it is quick and easy to do.  All UI settings,
hot keys and other customized information are stored in a small XML file,
allowing for easy distribution of all customized presets.

18.1  Customize Hot Keys
To define a hot key is very simple. All you need to do is point your cursor
over the item you would like to set a hot key for and press the END key --
you will then see this prompt:
You can now press the key(s) you would like to assign to the function. Keep
in mind that nearly every button or menu item you see in 3D-Coat already
have a custom hot key. If a hot key is already used, it is no problem to
re-assign the hot key to whatever new hot key you would like.

18.2   Customize User Interface
The UI layout of 3D-Coat is fully customizable.
By default there are three UI themes included
in the installation. They are “Dark”, “Grey”
and “Light”. You can change this by going to
Edit–>Preferences–>Load, and you will then
be directed to a folder named “OptionsPre-
sets. There are 3 .XML files in it, and each of
them is corresponds to an interface theme. To
load the themes, simply select one .XML file
and click Open. You can of course edit many more parts of the UI and create
your own UI theme and save it as an .XML file. Just go to Edit->Preferences.
Here you can customize the color of text, interface background, header,
buttons, grid, background, and so on. You can also turn on/off 3D button
style, Gradient menus.

After all these done, just save the .XML file, and all the new customized
information are stored. You can load it anytime on your own systems or
share it with your friends and colleagues. Simply press the button Save in
the Preferences panel.

You can even change the icons of the tools to your own, just go to the
installation folder of 3D-Coat. In the subfolder path textures\icons you will
find the source .PSD files of the icons, they are Baseicons..PSD and
SmallIcons..PSD, open the .PSD file in Photoshop and create your own
icons. When finished, save them in the .DDS format, keep the name and
replace the original Baseicon.DDS and SmallIcons.DDS. The next time you
start 3D-Coat it will load all the new custom icons.

19.0  CUDA

19.1 CUDA Basics
3D-Coat uses CUDA acceleration for voxel sculpting only. Voxel sculpting
requires more computing resources because it handles pictures in volume.
So we decided to use CUDA to speed up volume operations. CUDA is
supported by all the recent NVidia cards, starting with the 8-series.

However the acceleration is hugely dependent on the number of proces-
sors available on the card. The real advantage of CUDA over a 4-core CPU
can be achieved only if the GPU has more then 64 processors, otherwise the
4-Core CPU alone will yield a better speed. So there is no reason to use
CUDA acceleration with some video cards, even though they support the
technology -- like the GeForce 8400/9400, 8500/9500, G100, G120, G130
and QuadroFX 1700 -- because they have less than 64 processors.

We can recommend any card from GeForce 9800GT (it’s very inexpensive)
and higher. Acceleration speed is dependent not only the number of cores
number but also on memory bandwidth.
CUDA gives the best speed advantage if you are applying masks and mate-
rials over voxel sculpture with big brushes. The speed advantage depends
considerably on the tool used.

19.2 The Benchmark
Here is the benchmarking info for a standard PC with a 4-core CPU (Q6600,
2.4 GHz, GPU 9800GT). We ran 6 tests, using several types of drawing with
a mask either enabled or disabled.
Draw with sphere: CUDA+thin pen(10) Avg. FPS:31.3
Draw with sphere: CPU+thin pen(10) Avg. FPS:30.5
Carve: CUDA+thin pen(10) Avg. FPS:34.1
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Carve: CPU+thin pen(10) Avg. FPS:30.5
Carve with mask: CUDA+thin pen(10) Avg. FPS:31.0
Carve with mask: CPU+thin pen(10) Avg. FPS:26.4
Draw with sphere: CUDA+thick pen(40) Avg. FPS:13.6
Draw with sphere: CPU+thick pen(40) Avg. FPS:10.4
Carve: CUDA+thick pen(40) Avg. FPS:18.3
Carve: CPU+thick pen(40) Avg. FPS:10.3
Carve with mask: CUDA+thick pen(40) Avg. FPS:14.3
Carve with mask: CPU+thick pen(40) Avg.
FPS:7.2

The largest advantage of CUDA over CPU-only is visible when a mask is
used. The faster FPS numbers means, of course, more speed. 9800GT is a
very low-priced card, but using a GTX260 or later or a QuadroFX with a
large amount of cores will give the best speed.

It is cheaper to buy a good video card than, for example, a Core i7 processor.
We can also recommend buying a video card with 1GB or more of memory,
because it will allow you to edit really large textures in 3D-Coat.

CUDA’s efficiency is limited on very large brushes, so, when reaching a
particular radius, CUDA will be automatically disabled in tools like the
Airbrush, Increase, Build and Smudge. On a scale of 1:1 it is a radius of
around 65. The surface and object tools are not getting any advantage
from CUDA.

19.3 Multi-Threading
A few operations in 3D-Coat are now multi-threaded! At the moment only

“merging” functions, such as the voxel Merge, Move and Pose tools, as well
as converting your voxel sculpt to surfaces in the voxel room to use the
surface sculpting tools. What is more, using the cache function in the voxel
room is also multi-threaded. These functions are now quite fast, where as
previously they were painfully slow in previous versions of 3D-Coat. At the
moment multi-threading is limited to a handful of functions, however, in
the near future many more functions will be added to the list of
multi-threaded tools, where applicable.

20.0  FAQ & Additional Tips
20.1 For Your Information!
Sometimes my painting operations become very slow. How can I best
avoid it?

Painting over large single faces will be much slower then over
dividedfaces. So try to avoid too big faces in UV-space. Divide large faces
whenever possible.

I am getting the error message “The application failed to start because
d3dx9_38.dll was not found”. What should I do?

Go to the Download page of the official 3D-Coat website, then download
DirectX 9c and install it. Even if you have DirectX 10 installed you need to
update DirectX 9. DirectX 9 and 10 are independent, so this procedure is
quite safe.

I want to upgrade my video card to speed up 3D Coat. What should I
choose?

Using modern nVidia cards is best, due to CUDA. You can choose from NV
8800GT (lowest price) to GTX 285 and higher. There is no reason to use
multiple GPU cards (SLI) for 3D-Coat. The most important factor for CUDA
performance is the number of cores -- it should be 120 or more. Video
RAM is important also, because it determines the maximum texture size
that can be edited in 3D-Coat. Every pixel takes 8 bytes, so you can easily
calculate the maximum size of the texture that can fit into the GPU’s
memory. We recommend you buy cards with at least 1 Gb of RAM, even
more is even better.

Do I need to uninstall 3D Coat every time I install your new software
upgrades?

No, you can install the update simply by overwriting the existing
installation (at least until we release a major, non-free version upgrade).



69/120

I am unable to register – every time I enter serial number and press
Register, 3D Coat restarts and asks for the serial number again. How
can I exit this loop?

Check if you might have copied to the clipboard extra characters -- or
missed some characters. Check that the serial number is for 3D-Coat Ver-
sion 3 -- often users are entering serial numbers for Version 2. Version 3
serial number begins with 3DC3SN-. If you are under Vista x64, please
ensure that you are running 3D-Coat as an administrator. If the problem
still persists try to delete the file License.dat from the 3D-Coat installation
folder manually.

There are too many texts hints in the interface, is there a way to hide
them?

If you are new to 3D-Coat, it isn’t recommended that you hide the hints,
because these will really be helpful for your study. But you can hide the
hints anytime you want, just go to the menu Edit->Preferences->Show
hints and uncheck that checkbox. You can turn on or off the big bottom
hints separately by using “Show big hints on the bottom panel”.

I am using Vista/XP 64-bit and 3D Coat does not respect my Wacom
pen pressure. What should I do?

3D-Coat works well with 64-bit drivers. Get the latest Wacom driver here:
www.wacom.com/downloads/drivers.php

Can I move/rotate/scale the objects but not the camera?

Yes, you can. In the “Sculpt mode” of tools panel, select the  “Select/Move”
command -- then you can select the object you want to
move/rotate/scale.

How can I adjust the pivot point?

In 3D-Coat, the pivot point is dynamic and based on the currently  picked
point (where you cursor last pointed on the model). But you can set the
pivot point manually using the “F” key. Also, please see the Camera menu

-- it lets you pick the best pivot mode.

What’s the difference between the normal maps standard used in 3ds
Max and Maya?

The green channel is reversed. You can select the normal maps standard
in the menu View->Options.

When should I use the DX version and when the GL version?

It depends on your hardware. 3D-Coat has two Graphics Modes: DX
(DirectX) and GL (OpenGL). the GL mode usually runs much faster than DX
mode on professional Quadro graphics card, while the DX  mode will run
faster on consumer-level game graphics card.

What’s the difference between “Depth” and “Sculpt mode”?

In 3D-Coat there are two types of sculpting modes: one is image-based and
another is mesh-based. “Depth” is image-based sculpting -- in this mode
you are drawing the depth by creating a vector displacement, the normal
map and displacement map is generated “on the fly.” If you want to get
hold of the normal map, just save it -- it’s not necessary to wait a long time
for baking, because the normal map is generated in real-time.

When you enter “Sculpt mode”, you enter the mesh-based sculpting mode.
In this mode you you’re really changing the vertex positions of the mesh. If
you want to get correct normal map in this mode, you may use Textures-
>Texture Baking Tool.

What’s the use of the Cavity painting?

Cavity painting lets you paint in the crevices of the surface without affect-
ing the rest of the area, and vice versa.

I selected the command “View->Environment Shade”, but there seems
to be no change, why?

You can only use “Environment Shade” if you have a specularity map in the
model. That means if you haven’t painted specularity on the model, you
will not see any change.
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Why is drawing with the SHIFT key so confusing?

Different sequences of the SHIFT key and the LMB will result in different
effects. If you first press and hold SHIFT and then draw with LMB, the
surface will be smoothed. But if you first press and hold LMB and then
press SHIFT and draw, you will get straight lines -- just like  in Photoshop.

How can I create a seamless texture using 3D Coat?

It is easy to use 3D-Coat to create seamless textures and bump maps. Just
go to menu File->Import->Image Plane, you may want to use Textures-
>Offset tool as well. You can read more about it on page.

What are the best practices regarding memory management and in-
creasing stability?

When 3D-Coat is run you can see the amount of
free memory in the  left bottom corner. If this value
becomes too low (200- 300 MB), the  program
can become unstable. These tips will help you to
increase  stability.

How can I find and safely edit the file “boot.ini”?

Right-click My Computer->Properties. The System Properties dialog box
will appear.

Click the Advanced tab.  In the Startup and Recovery area, click Settings.
The Startup and Recovery dialog box will appear. In the System startup
area, click Edit. This will start Notepad and open “boot.ini”.   In the [Operat-
ing Systems] section, add the following switches to the end of the startup
line that includes the /fastdetect switch: /3GB Save the changes and close
Notepad.  Click “OK” twice to close the dialog boxes, and then restart the
computer for the change to take effect.

You can read more about the /3GB option here:
http://technet.microsoft.com/en-us/library/bb124810. aspx
http://www.vfxpedia.com/index.php?title=FAQ/3GB_ Switch

20.2 Video Tutorials
There are many video tutorials out there for 3D-Coat. If you’re looking an
answer to a specific question, or just want to get some idea of what 3D-
Coat is capable of, check out the video training at some of the links below:
http://www.3d-coat.com/tutorial/
http://vimeo.com/channels/3dcoat
http://vimeo.com/channels/3dctraining
http://vimeo.com/user2003041/videos
http://www.vimeo.com/gregwhedon/videos
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22.0  Printing This Manual
You may of course also print this manual! But you probably don’t want to
waste unnecessary ink. Please follow these simple instructions to remove
the grey background in this PDF document.

In Adobe Reader, first move your cursor to View->Navigation Panels-
>Layers. You should then see, on the left side, a new panel called “Layers”.
You will only see “3DC-Manual” or something similar. Then click next to the

“+” icon to expand the Layer system. You should see a layer named “Gray
background”, and right next to it a visibility icon, represented by an eyeball.
Click the eyeball to toggle the visibility off. All this is clearly shown in the
images on this page.

You should now see a white background in this document, and can print it
using much less ink.

If you want to save even more ink, you can also hide the layer named
“Images” -- and only print the text parts of this manual.

23.0  Applinks

The development of “live” links between 3D-Coat and other commercial 3D
applications is an ongoing project.  So, consider some of these “Links” as
beta versions.  As of this printing, the list of available Applinks is as follows:

Maya, 3DSMax, Lightwave, Modo, Houdini, SoftImage, C4D,
 Messiah Studio, Cheetah3D, Unity3D, Blender, Zbrush, Modo

After installing you should run your App, then run 3D-Coat. There should
appear the new menu in 3D-Coat - File-> Open in -> Your app name.
You may use this item to bring 3D-Coat's models from any room (Paint,
Retopo, Voxels) to your app with color, normal, displacement and specular.
But you should choose what you need - displacement or normalmap, not
both at once.

Also you may bring your models from your app to 3D-Coat using plugin. In
this case you will get new item in menu - File -> Open in original app.  In this
way you may bring model back to your app.

Find your Applink at :   http://3d-coat.com/applinks

24.0 Beta tools

Edit->Preferences->Show beta tools.

Beta tools are mostly intended to be in the next V4 but if you want you may
enable them.

Beta tools are mostly boolean operations and Live Clay related.

These tools are very powerful and developed rapidly.
This is short list of tools that are accessible right now in the 3.7 release:

- Live Clay tools - dynamic tessellation
- Dynamic tessellation for existing tools in voxel surface mode
- Boolean operations. You may use primitives and the Merge tool to add or
subtract models in a voxel surface scene.
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- boolean operations between volumes - add/subtract/intersect volumes in
surface mode without converting to voxels

- remove mesh self intersections, cleaning mesh up, closing holes.

25.0  What’s New In Version 3.7

3D-Coat v3.7 Featuring Applink Connection Plug-ins

Change List:

Applink Connection Plug-ins!
New brush engine!

- Support of instancing (See the Instancer tool + the new check box in the
Merge tool). It gives the ability to use one volume multiple times in the
scene without any additional memory consumption. For example, you may
take several bricks and make a building of them, keeping the scene very
light, and only initial bricks will use memory. This  way you can manage
really huge scenes, provided they can be decomposed into a smaller num-
bers of basic elements. The scene in the viewport will also be rendered
faster because of significantly less video memory consumption. It is ex-
tremely helpful for architecture, hard surface modeling, and often for or-
ganic elements (scales, teeth).

- New CutOff tool allows you to perform very precise boolean operations!

Voxel Mode:
- Speed-up in voxel surface mode.
- New voxel export option - "File->Export projected quads" - alternative
high quality quad only voxel export

- Realtime preview for Sketch tool. You will see the summary volume imme-
diately while painting.

- Free form transformations in Pose tool. Example, http://bit.ly/itnFBA ,
http://bit.ly/jed7ym

- Rapid2/Mud2 brushes are smoother and nicer versions of Rapid/Mud
brushes. These new brushes are based on the same principle as the new
Clay brush.

- New brush, based on surface clay, that is similar to the Build brush, in the
Voxel room and Wax in MB. It is a modification of the Clay brush, and it is a
super cool method for building up a shape.

- Optional ability to merge a mesh into a voxel scene without actual vox-
elization. It will appear in voxel surface mode and will be voxelized when
you turn it to voxel mode.

- Ability to save separate voxel layers as 3B files (with sub-tree or without).
- Improved Model/Splines tabs in Voxel room. You will be able to add new
profiles, drag volumes/external objects to those windows,
Add/delete/rename items/folders. Importing a spline profile is now very
user-friendly. It is possible to use Drag&drop or VoxTree RMB menu.

- Arbitrary change of resolution of voxel volume. You may change mesh
resolution to any given number of polygons.

- New command "Apply to visible" and "Apply to subtree" in the Shaders
RMB menu.

- Extrude - like tools in voxel mode improved - they will work in lines mode
(snap to surface) with a more uniform stroke.

- Rapid/scratches/mud brushes tuned to be more "clay-like".
- New brushes: Scratches, Mud, Inflate.
- New tool in voxels - Clone. It acts like Cut&Clone but skips cutting.
- http://t.co/U0acUZY . It may copy just the surface if needed - super cool to
create clothes, stamp logos, shells - http://t.co/gjcmrwL . In general, it
allows you to paint over a voxel model with different colors/shaders, of
course without blending - http://t.co/WcbU470

- Support of painting/carving over planes/surfaces defined by 3 or 4 points
- http://bit.ly/gk6xi0 , http://bit.ly/el1Sql

Paint Mode:
- Essential speedup in per-pixel, microvertex and ptex mode.
- Two new powerful tools in Paint room (Layers menu) - Clamp depth and
Copy channels. Both respect freeze. Copy channel allows you to copy any
channel (R,G,B, Luminosity, Alpha, Specular, Depth) to any other channel of
any layer. Copying masked by freeze.

- New option Import->Import geometry in the Paint room. In this way you
will be able to change geometry/topology in your external editor, preserv-
ing layers. Imported geometry may have changed topology but UV config-
uration should be preserved at least approximately. Works only for
per-pixel painting.
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- Projection painting in Photoshop improved a bit - now you may edit
projection even if inside an object, (e.g. Skybox).

- All blending modes in the Paint room are synchronized precisely with
Photoshop.

- Baking improved.
- New important command in Ptex mode “Fit in one texture” introduced.
- Support of alpha images mip-mapping. It leads to really good stroke quality.
- Compare: http://bit.ly/ea0WCL and http://bit.ly/eS5cqK . It is especially
important if a contrasty high resolution alpha is used. Old style stroke was
too noisy, new style is very smooth like it is in PS. More images to compare:
http://bit.ly/guuQjL and http://bit.ly/eWxOZz

-  Much more accurate fading of edges while updating projection created in
Photoshop, etc: http://bit.ly/fqs2I6

- Ability to paint over materials and masks directly in 3D-Coat -
http://bit.ly/oY8ojw

- Updated OBJ files support. Now you will be able to import color, specular,
normal, displacement maps during OBJ import. Here is the document that
describes the changes - http://bit.ly/gUUi45

- Possibility to paint through an object - start stroke beside the object or end
stroke beside the object.

- "Copy channels" command is added to Layers RMB menu.
- New option in brush settings - "Vary color along stroke" to be able to draw
fur-like textures.

- Ability to choose the style of brushing in Paint mode and Voxel surface
mode – new function to produce a smooth stroke shape with self intersec-
tion, as found in PS - or you can opt for old-style (but improved) strokes
with strict adherence to an alpha shape (but with strict self intersection).

- Hue, Saturation, Lightness jitters are implemented in the Brush options
panel.

- Depth painting quality in ppp improved a lot, now it is very smooth and
accurate.

- Much better projection connection with your external image editor. It will
fade edges accurately - imported image will be more accurate. It will be
possible to apply projection through an object if desired.

- Every tool stores its own brush/alpha. It can be turned off in preferences.
- Loading for ppp, change map resolution, Apply UV, Fill tool are now
multicore optimized to work much faster.

Retopo & UV Mode:

- Autopo improved.
- Auto UV-mapping improved.
- Clone function in Retopo->Select [faces] to clone parts of a mesh.
- Ability to transform the whole retopo mesh or its selected parts with new
Transform tool in the Retopo room.
- Transform gizmo in Retopo tool now has "To local space" button to orient
the widget according to the main axis of selected elements. It orients the
widget intelligently according to the selected elements.

- Ability to see the number of UV vertices in the Retopo room. It is important
if you have a budget of polygons for a game model.

- Support of copy-paste in the UV tool - http://bit.ly/e1hFqU . It is useful to
perform UV mapping over repeatable or symmetric details.

- Support of multiple UV-sets in the Retopo room.
- Only visible faces will be baked in the Retopo tool during baking operations.

Other changes:
- New user-friendly way to share 3D-Coat's resources - http://bit.ly/iEndgn .
You may easily create extension packs (3dcpack) with your own Brushes /
Strips / Materials / Masks / Shaders / Navigation etc.

- If SHIFT and LMB are pressed simultaneously - and even if SHIFT is released,
but LMB pressed - 3DC will act as if SHIFT is still pressed.

- Drag and dropped image may be assigned to be a background.
- 3D-Coat now creates a jpeg with preview in same folder where a 3B file is
saved. Clicking on them will open the 3B file.

- Symmetry panel has a new "Lock symmetry plane" checkbox to lock the
symmetry plane and avoid unnecessary movement by accidentally hitting
the TAB key. Also ALT-TAB will not conflict with TAB pressing to move the
symmetry plane.

- Ability to load grayscale pictures as contours in the E-panel (through "Load
shape" button).

- EPS file format supported for importing shapes for the E panel.
- Hiding/showing all but this layer using ALT will work for everything that
has an eye icon - retopo, objects, materials, voxels, paint layer.

- ZBrush-like navigation preset for ZBrush fans.
- SHIFT-axis-snapping when navigating.
- 3D-Coat will detect tablet pressure levels automatically.
- Overall speed-up everywhere.
- Lots of bug fixes and tweaks.
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